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Foreword

The National Curriculum Framework–2005 (NCF–2005) recommends 
bringing work and education into the domain of the curricular, infusing 
it in all areas of learning while giving it an identity of its own at relevant 
stages. It explains that work transforms knowledge into experience and 
generates important personal and social values, such as self-reliance, 
creativity and cooperation. Through work one learns to find one’s place 
in the society. It is an educational activity with an inherent potential 
for inclusion. Therefore, an experience of involvement in productive 
work in an educational setting will make one appreciate the worth of 
social life and what is valued and appreciated in society. Work involves 
interaction with material or other people (mostly both), thus creating 
a deeper comprehension and increased practical knowledge of natural 
substances and social relationships.

Through work and education, school knowledge can be easily linked 
to learners’ life outside the school. This also makes a departure from 
the legacy of bookish learning and bridges the gap between the school, 
home, community and the workplace. The NCF–2005 also emphasises on 
Vocational Education and Training (VET) for all those children who wish 
to acquire additional skills and/or seek livelihood through vocational 
education after either discontinuing or completing their school education. 
VET is expected to provide a ‘preferred and dignified’ choice rather than 
a terminal or ‘last-resort’ option.

As a follow-up of this, NCERT has attempted to infuse work across 
the subject areas and also contributed in the development of the 
National Skill Qualification Framework (NSQF) for the country, which 
was notified on 27 December 2013. It is a quality assurance framework 
that organises all qualifications according to levels of knowledge, skills 
and attitude. These levels, graded from one to ten, are defined in terms 
of learning outcomes, which the learner must possess regardless of  
whether they are obtained through formal, non-formal or informal 
learning. The NSQF sets common principles and guidelines for a 
nationally recognised qualification system covering Schools, Vocational 
Education and Training Institutions, Technical Education Institutions, 
Colleges and Universities.
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It is under this backdrop that Pandit Sunderlal Sharma Central 
Institute of Vocational Education (PSSCIVE), Bhopal, a constituent 
of NCERT has developed learning outcomes based modular curricula 
for the vocational subjects from Classes IX to XII. This has been 
developed under the Centrally Sponsored Scheme of Vocationalisation  
of Secondary and Higher Secondary Education of the Ministry of 
Education, erstwhile Ministry of Human Resource Development.

This textbook has been developed as per the learning outcomes 
based curriculum, keeping in view the National Occupational Standards 
(NOS) for the job role and to promote experiential learning related to 
the vocation. This will enable the students to acquire necessary skills, 
knowledge and attitude.

I acknowledge the contribution of the development team, reviewers 
and all the institutions and organisations, which have supported in the 
development of this textbook.

NCERT would welcome suggestions from students, teachers and 
parents, which would help us to further improve the quality of the 
material in subsequent editions.

Hrushikesh Senapaty

Director
New Delhi				    National Council of Educational
September, 2020			   Research and Training
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About the Textbook

Indian animation companies are creating animated multimedia content 
for film and animation industry. One of the key stages in the production 
of animated content is texturing, which is done by a ‘Texturing Artist’.

A Texturing Artist creates and modifies textures and mounts them on 
3D models. The textbook on the job role of a Texturing Artist has been 
developed to impart knowledge and skills through hands-on-learning 
experience. 

The textbook has been developed with the contribution and expertise 
provided by subject and industry experts and academicians for making it 
a useful and enriching teaching-learning resource material for vocational 
students. Care has been taken to align the content of the textbook with 
the National Occupational Standards (NOSs) for the job role so that they 
acquire necessary knowledge and skills as per the performance criteria 
mentioned in the respective NOSs of the Qualification Pack. The textbook 
has been reviewed by experts so as to ensure that the content is not only 
aligned with the NOSs but is also of high quality. 

Unit 1 of the textbook explains the colour theory, which includes 
the principles of colour theory, colour wheel, digital colour wheel, 
RGB display mechanism and colour schemes. Unit 2 focuses on the 
various aspects of digital photography, camera angles and movements 
and pre-production. Unit 3 deals with the various tools of Adobe 
Photoshop for drawing and painting. This software has been used as 
an exemplar for developing understanding about the various tools 
used in texturing, as most teachers or trainers are familiar with it. 
Unit 4 will help students to learn about the lighting in photography 
and correct exposure in terms of depth of field and recording of 
movement.

Vinay Swarup Mehrotra

Professor and Head
Curriculum Development and 

Evaluation Centre and NSQF Cell,
PSSCIVE, NCERT, Bhopal
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Texture, which means the feel, appearance or  
consistency of a surface or a substance, is the perceived 
surface quality of visual art. Texturing demands 
competency in the techniques of art, as well as, design. 
Art, as you know, is the knowledge of the theory and 
techniques required to compose, produce and perform 
works of visual arts and sculptures. 

The visual arts are the various art forms, which 
include drawing, painting, crafts, photography, 
videography, filmmaking, architecture and sculpture.

Design, which is the knowledge of techniques, tools 
and principles involved in the production of precision 
blueprints, drawings and models, is the process of 
selection of all visual elements used by artists to express 
themselves. These elements include shape, value, texture, 
colour, line, mass and space. The elements could be  
two-dimensional (2D) and three-dimensional (3D). 

Texture instills an image with depth and detail. Any 
element that has texture attracts the viewer more as 
compared to a plain visual, as it tempts the viewer to 
imagine the feel of the texture. To promote the detailing 
in a texture, elements like colours, shadows, mid-tones, 
highlights and effective lighting are applied.

A Texturing Artist must have an in-depth 
understanding of the colour theory, and nature and 
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Texturing Artist — Class XI

content of the artwork to be produced. They should 
be well versed with the vocabulary of terms specific to 
the visual arts, and two or three dimensional designs. 
The person must be able to apply different textures, 
using  suitable software for image manipulation, and 
to maintain portfolios of artistic work, especially to 
demonstrate one’s styles, interests and abilities. 

In this Unit, you will learn about colour wheel, and 
the application of colour theory in texturing. 

Session 1: Principles of Colour Theory

Light is made up of wavelengths of light, and each 
wavelength is a particular colour. Visible light waves 
consist of different wavelengths. These wavelengths 
range from 700 nm (nanometer) at the red end of the 
spectrum to 400 nm at the violet end. White light is 
the combination of many different frequencies of visible 
light from all parts of the visible spectrum. The colour of 
an object or material is determined by the wavelengths 
it absorbs and those it reflects. An object has the colour 
of the wavelengths it reflects. Thus, the colour that we 
see is a result of the wavelengths that are reflected back 
to our eyes. The primary colours of light are red, green 
and blue. Mixing these colours in different proportions 
can make all the colours of the light that we see. There 
are basically three categories of colours, based on the 
colour wheel — primary, secondary and tertiary colours.

Colour Theory
Colour theory is a term used to describe the rules and 
guidelines regarding the use of colour in art and design.

Colour theory focuses on colour mixing and visual 
effects of a specific colour combination. Combining 
colours is both an art, as well as, a science. You might 
be aware that there are primary colours, secondary 
colours, and tertiary colours. 

Primary colours are a set of colours that can be 
combined to make a useful range of colours. Red, blue 
and yellow are the primary colours, and form the base 
of every other colour. Primary colours can be mixed 
together to produce secondary colours. 

Notes
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There are many theories for harmony. However, 
there are three basic categories of colour theory that are 
logical and useful — the colour wheel, colour harmony, 
and the context of how colours are used. Colour harmony 
provides a visual interest and a sense of order.

Colour wheel
The colour wheel can be used to help remember 
primary and secondary colours. Tertiary colours 
are combinations of primary and secondary colours  
(Figure 1.1). 

Primary

Secondary

Tertiary

Fig. 1.1: Primary, Secondary and Tertiary Colours

As a Texturing Artist, an individual develops textures 
for the digital media, which could be in the form of 2D 
or 3D art that may be overlaid onto a polygon mesh to 
create a realistic 3D model. The Texturing Artist must 
understand how a particular colour behaves in relation 
to other colours and shapes, which is a complex part 
of the colour theory. By selecting the right colour from 
the colour wheel, the Texturing Artist can create an 
ambience of elegance, warmth or tranquility using cool 
or warm colours. 

Colour harmony
Colour harmony refers to the property which is 
created through an aesthetically pleasing colour 
combinations.
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Colour context
The relationship of values, saturations and the warmth  
or coolness of hues should be understood by the 
Texturing Artist, as these create differences in our 
perception of colour.

History of Colour Theory
The ‘colour theory’ principles were first written by  
Leone Battista Alberti (c.1435). Colour theory is a 
set of principles used to create harmonious colour  
combinations. A harmonious colour is the one that is 
next to another on the colour wheel or very close to it. 
For example, red is near rust, which is near terracotta.
It guides us to the practical way of colour mixing.

Fig. 1.2: Colour arrangement within the visible range of light

400
(ultra Violet)

450
Blue

500 
Cyan

550
Green

600 
Yellow

650 
Orange

700
Red

750
(infra)

The first colour wheel was designed by Sir Isaac 
Newton in 1666. He worked successfully by splitting 
white sunlight into six different colour beams, namely 
red, orange, yellow, green, cyan and blue (Figure 1.2). 
Then, he joined together the two ends of the colour 
spectrum to show the natural progression of colours. 
Newton had associated colours with the note of a  
musical scale.

A century later, Johann Wolfgang von Goethe 
worked on the psychological effects of colours. He 
noticed that blue gives a psychological feeling of 
coolness and yellow gives a warming effect. According 
to the frequency of different colours, colours are 
arranged within the visible range of light. Goethe, 
later, created a colour wheel, which depicted the 
psychological effect of each colour. He bifurcated 

Notes
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all colours into two groups —‘plus 
side’ (from red through orange to 
yellow) and ‘minus side’ (from green 
through violet to blue). Excitement 
and cheerfulness were placed in the 
area of plus side colours, whereas, 
weakness and unsettled feelings 
were associated with the minus 
side. The current form of colour 
theory was developed by Swiss 
colour and art theorist Johannes 
Itten, who taught at the School of 
Applied Arts in Weimar, Germany. 

The ‘colour chords’ were 
developed by Itten (Figure 1.3), 
who also modified the colour wheel. 
Itten’s colour wheel is based on  
the primary colours — red, yellow 
and blue and it includes 12 hues of 
the same.

Basic Terms Related to Colour 
Theory
Hue, saturation and value are the 
three components of a colour.

Hue
It is one of the main properties of a 
colour, which permits a colour to be 
classified as red, yellow, green, blue, 
or an intermediate colour between 
any contiguous pair of these colours 
(Figure 1.4 and 1.5).

Saturation
Saturation in colour theory can be 
defined as the purity of a colour.
Hundred per cent saturation is the 
maximum purity limit of a colour 
(Figure 1.4).

Fig. 1.3: A view of colour chords

Fig. 1.4: A view of hue, saturation and value

Hue

Saturation

Value

Under saturated

Low value High value

Very saturated

Fig. 1.5: Colour palette of Adobe Photoshop, showing 
hue, saturation and brightness graph 

Saturation 100% Saturation
0% Brightness

100% Saturation
100% Brightness

0% Saturation
0% Brightness

0% Saturation
100% Brightness

Value 
or 

Brightness
Hue
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Value
The colour value is the brightness or lightness of a 
colour (Figure 1.4 and 1.5).

Tint
Tint can be achieved by adding white to any hue. 

Tone
Tone can be achieved by adding grey to any hue. 

Fig. 1.6: Colour palette of Adobe Photoshop showing tint, shade and tones from white to hue,  
black to hue and grey to hue, respectively

Tint Shade Tone

Fig. 1.7: Colour Palette of Adobe Photoshop showing tint, shade and tone

Tints — adding white to a pure hue

Shades — adding black to a pure hue

Tones — adding grey to a pure hue
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Shade

Shade can be achieved by adding black to any hue.
(Figure 1.6 and 1.7)

Practical Exercises
Activity 1

Creating a colour wheel with red, green and blue colours.

Material required

cardboard, water colours, brush, water and colour mixing 
palette

Procedure

yy Create a circular disc of a cardboard or a white sheet. 
yy Divide this disc into three equal parts with a pencil and 

scale, and paint each part with red, green and blue, 
respectively. 

yy Insert a stick having a pointed tip, or a sharpened pencil 
in the centre of the coloured disc. 

yy Now, spin this disc with the help of the stick or pencil. 
yy Observe the colour that the circular disc shows when 

rotated. 
yy Write down the colours that you saw, while spinning 

the disc.

Activity 2

Creating a colour wheel with cyan, magenta, yellow and black

Material required

cardboard, colours, brush, water and colour mixing palette 

Procedure

yy Cut a white paper into a circular disc. 
yy Divide the disc into four equal parts, with a pencil and 

scale. 
yy Now, paint each part with cyan, magenta, yellow and 

black, respectively. 
yy Insert a stick having a pointed tip or a sharpened pencil 

in the centre of the coloured disc. 
yy Now, spin this disc with the help of the stick or pencil. 
yy Observe the colour that the circular disc shows when 

rotated. 
yy Write down the colours that you saw while spinning  

the disc.

Notes
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Session 2: Colour Wheel

A colour wheel or colour circle is an abstract illustrative 
organisation of colour hues around a circle that shows 
the relationship between primary, secondary and 
complementary colours. Colour wheel or colour circle 
was developed by Sir Isaac Newton by taking the colour 
spectrum and bending it into a circle. If you follow the 
colour wheel, you will find the same order of the colour 
spectrum —red, orange, yellow, green, blue, indigo 
(blue-violet), and violet.

Most colour wheels are based on three primary 
colours, three secondary colours and the six 
intermediates known as tertiary colours.

According to the colour theory, harmonious colour 
combinations use any two colours, which are opposite 
to each other on the colour wheel. Any three colours 
are equally spaced around this colour wheel forming a 
triangle.

Check Your Progress
A.	 Fill in the Blanks

1.	 The property that permits a colour to be classified 
as red, yellow, green, blue or an intermediate colour 
between any contiguous pair of these colours is known 
as _____________.

2.	 The purity of colour is known as ______________.
3.	 The colour _____________ is the brightness or lightness 

of colour.
4.	 Tints are obtained by adding ________________ to a pure 

hue.
5.	 Shades are obtained by adding _________________ to a 

pure hue.
6.	 Tones are obtained by adding________________ to a 

pure hue.

7.	 A colour theory can be broken down into three parts—
colour ______________, colour harmony and colour 
context.

What have you learnt?
On the completion of this Session, you will be able to:

yy describe the basic colour theory principles.
yy explain the meaning of terms related to colour theory.

Notes
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Types of Colour Wheel
Depending on different mediums of using colour, colour 
wheel can be categorised into the following two types.

Artist colour wheel
The Artist colour wheel is the chart 
which is generally used for mixing 
colours for painting and artwork  
(Figure 1.8).

Technical colour wheel
Technical colour wheel is used to work 
with any technical device like electronic 
display and printers (Figure 1.9). It can be 
categorised into the following two types:

Digital colour wheel
Mixing colours digitally is not the same as mixing them 
physically, therefore, it is important to understand 
digital colour mixing. Screens use an additive colour 
model (the additive primary colours are Red, Green, 
and Blue i.e., RGB) rather than the reflective colour 
model. Television, cameras, scanners and computer 
monitors are based on the additive system of colour, 
where red, green and blue light projected together yield 
white colour. Digitally storing an image requires that it 
should be broken down into a grid of tiny pixels.

Print media colour wheel
Print media creates colour by subtracting or absorbing 
certain wavelengths of colour while reflecting other 
wavelengths back to the viewer. This phenomenon is 
called subtractive colour model. It uses Cyan, Magenta 
and Yellow (CMY) pigments or dyes to subtract portions 
of white light illuminating an object to produce other 
colours. Traditionally, the primary colours used in 
subtractive process were red, yellow and blue, as these 
were the colours that Painters used to mix to get all 
the other hues. The subtractive colour system involves 
colourants and reflected light. Colour paintings, colour 
photography and colour printing processes use the 
subtractive process to reproduce colour.

Fig. 1.8: Artist colour wheel

Unit-1.indd   9 1/20/2021   11:50:36 AM
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Types of Colours
The colour wheel is made up of three types of colours — 
primary, secondary and tertiary. Let us now try to 
understand the three types of colours and their 
formation.

Primary colours
Primary colours are the basic colours on the colour 
wheel. These are called so because no two colours can 
be mixed to create a ‘primary colour’. All other colours 
found on the colour wheel can be created by mixing the 
primary colours (Figure 1.10). The three primary colours 
of artistic colour wheel are Red, Yellow and Blue (RYB).

Secondary colours
Secondary colours are created by mixing equal parts 
of any two primary colours. The secondary colours are 
orange, green and purple.

Red + Yellow = Orange
Yellow + Blue = Green
Blue + Red = Violet (purple)

Tertiary colours
A tertiary colour is made by mixing one primary colour 
and the adjacent secondary colour. Such colours 
are created by mixing equal parts of a primary and 

Red

YELLOW

BLUE

Fig. 1.10: Primary colours

Fig. 1.9: Technical colour wheel (a) and (b)

Yellow
(Primary)

Blue
(Primary)

Yellow Green
(Tertiary)

Green
(Secondary)

Blue Green
(Tertiary)

Blue Purple
(Tertiary)

Purple
(Secondary)

Red Purple
(Tertiary)

Red 
(Primary)

Orange Red
(Tertiary)

Orange 
(Secondary)

Yellow Orange
(Tertiary)

(a) (b)
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secondary colour. There are six tertiary colours, namely 
red-purple, red-orange, blue-green, yellow-green, blue-
purple, and yellow-orange. 

Check Your Progress
A.	 Fill in the Blanks

1.	 A colour wheel shows the relationship between 
______________, secondary and complementary colours.

2.	 Colour wheel can be categorised into ______________ 
and technical colour wheel.

3.	 Technical colour wheel can be categorised into 
______________ and print media colour wheel.

4.	 Mixing red and yellow gives ______________.
5.	 Mixing yellow and blue gives ______________.
6.	 Mixing red and blue gives ______________.
7.	 In RYB artistic colour wheel, R stands for ______________, 

Y for ______________and B for ______________. 

B.	 Subjective Questions

1.	 What are the two types of technical colour wheel? Write 
a short note on each of them.

2.	 Write a short note on the following:
	 (i)	 Primary colours
	 (ii)	 Secondary colours
	 (iii)	 Tertiary colours

Practical Exercises
Activity

Mixing two colours to generate a third colour

Material required

poster colours (red, yellow and blue), colour mixing palette, 
water and drawing sheets

Procedure

yy Mix the following colours in equal proportion to generate 
a third colour:
1.	 Red and yellow
2.	 Yellow and blue 
3.	 Blue and red 

yy Write a note on the new colours generated.

Notes
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What have you learnt?
On the completion of this Session, you will be able to:

yy differentiate between primary and secondary colours.
yy differentiate between secondary and tertiary colours.
yy mix primary colours to prepare secondary and tertiary 

colours.
yy create a colour wheel from primary colours.
yy distinguish between artistic and technical colour wheel.

Session 3: Digital Colour Wheel

You have learnt in the previous session that a digital 
colour wheel, also called as ‘RGB colour model’ is an 
‘additive colour model’. In this model, Red, Green, and 
Blue light are added together in various proportions 
to reproduce a broad spectrum of colours. The model 
derives its name from the first letter of the three additive 
primary colours — Red, Green and Blue.

The RGB colour model is used to represent and 
display images in electronic display devices, such as 
television, projector, and monitor. It is also used in 
digital photography. The typical RGB output devices 
are colour television, monitor, multimedia projector and 
mobile phone display, which use either TFT (Thin Film 
Transistor), LCD (Liquid Crystal Display), LED (Light 
Emitting Diode), OLED (Organic Light Emitting Diode) 
or Plasma Technology and RGB input devices, which 
include video cameras, image scanners and digital 
cameras. Colour printers, on the other hand, are not 
RGB devices but subtractive colour devices, typically 
CMYK [Cyan Magenta Yellow Key (Black)] colour model 
(Figure 1.11).

To form a colour with RGB, three coloured light 
beams (red, green and blue) must be superimposed 
(for example, by emission from a black screen, or by 
reflection from a white screen). Each of the three beams 
is called a component of that colour, and each can have 
an arbitrary intensity, from ‘fully off’ to ‘fully on’ in the 
mixture. The RGB model is an additive colour model, 
in which the three light beams are added together and 
wavelengths of the light spectra are added to make the 
final spectrum of the colours.

Notes
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Zero intensity for each 
component gives the darkest 
colour, and full intensity of 
each gives a white. The quality 
of white depends on the nature 
of primary light sources, but if 
they are properly balanced, the 
result is neutral white. When 
the intensity of all component 
colours is the same, the result 
is a shade of grey, which is 
darker or lighter, depending 
on the intensity. When the 
intensities are different, the 
result is a colourised hue, more 
or less saturated, depending on 
the difference of the strongest 
and weakest intensities of the primary colours employed.

When one of the components has the strongest 
intensity, the colour is a hue near that primary 
colour (reddish, greenish or bluish). When two 
components have the same strong intensity, 
then the colour is a hue of a secondary colour (a 
shade of cyan, magenta or yellow). A secondary 
colour is formed by mixing two primary colours of 
equal intensity. Cyan is formed by adding green 
and blue, magenta with red and blue, and yellow 
with red and green. Every secondary colour is 
the complement of one primary colour. When 
a primary and its complementary secondary 
colours are added together, the result is white. 
Cyan complements red, magenta, green, yellow 
and blue (Figure 1.12).

A digital image created in RGB mode stores 
each colour value in an ‘8 Bits Channel’. Hence, 
red value is stored in an 8 Bits Channel, green 
in a separate 8 Bits Channel, and blue in yet 
another 8 Bits Channel. Hence, the RGB image 
has 8 Bits × 3 Channels = 24 Bits image. This 
image will have 224 colour = 16.78 million colour 
shades (true colour image).

Fig. 1.11: RGB colour wheel

Red
0°  
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330°  
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255-0-255
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0-0-255

Ocean
210°  

0-255-255

Orange
30°  

255-125-0

Yellow
60°  

255-255-0

Spring Green
90°  

125-255-0

Green
120°  

0-255-0

Turquoise
150°  

0-255-125Cyan
180°  

0-255-255

RGB
Magenta

Red

Yellow

White

Green

Cyan

Blue

Fig. 1.12: RGB colour model
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Print media colour wheel
yy Primary colours for print media colour wheels are 

cyan, magenta and yellow.
yy Digital colour wheels are often called CMYK model 

(Figure 1.13).
yy CMYK colour model is a subtractive colour model.

The CMYK colour model (a four colour process  
model) is a subtractive colour model used in colour 
printing. It is used to describe the colour printing 
process. CMYK refers to the four colour inks used in 
printing, which are — cyan, magenta, yellow and key 
(black) (Figure 1.14).

The ‘K’ in CMYK represents ‘Key’ because 
in four-colour printing, cyan, magenta and 
yellow printing plates are carefully ‘keyed’ or 
aligned with the ‘key’ of the black key plate 
(Figure 1.14). The ‘K’ in CMYK stands for Key, 
which denotes ‘black’. The reason for not using 
the ‘B’ of ‘black’ is that this letter represents 
‘blue’ in the RGB model, which was developed 
earlier. CMY being the complementary 
(subtractive) colours, which when mixed 
together must theoretically generate ‘black’ 
(absence of all colours). The ‘black’ generated 
by mixing cyan, magenta and yellow inks 
is not exactly black, it generates a ‘muddy 
brown’ colour. Hence, four-colour printing 
uses the extra fourth colour pigment, i.e., 
black ink, to create a pure black colour. 

A digital image created for the print media 
in CMYK mode stores each colour value in 
an 8 Bits channel. Hence, cyan colour value 
is stored in an 8 Bits channel; magenta is 

stored in a separate 8 Bits channel, yellow in another 8 
Bits channel, and black in yet another 8 Bits channel. 
Hence, a CMYK image has 8 Bits × 4 Channels = 32 Bits 
Image. 

Another type of 32 Bits image is RGB + α-Channel 
image. An α-Channel saves the transparent background 
of that image in an 8 Bits channel. Hence, it has 24 Bits 
of RGB and 8 Bits of α-Channel, thereby, creating a 32 

C
Cyan

Y
YELLOW

M
mAGENTA

B
BLACK

Fig. 1.13: CMYK colour model

CMYK
Blue

Magenta

Red

Black

Yellow

Green
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Fig.1.14: Subtractive colours 
or CMYK colour model

Unit-1.indd   14 1/7/2021   2:10:32 PM



Colour Theory

15

Bits image. These types of images with α-Channel are 
used in videos and 3D animation. The alpha channel 
stores transparency information. It is extremely useful 
for compositing digital images together.

Check Your Progress
A.	 Fill in the Blanks

1.	 The main purpose of RGB colour model is for 
representation and display of images in ____________
media.

2.	 Input devices, such as video camera, image scanner 
and digital camera use ______________colour wheel.

3.	 Primary colours for print media colour wheel are cyan, 
magenta, _____________________ and black. 

B.	 Subjective Questions

1.	 Write a short note on RGB colour model.
2.	 Write a short note on CMYK colour model. 

What have you learnt?
On the completion of this Session, you will be able to:

yy describe the RGB model.
yy select colours from the colour wheel as per the 

requirement.

Practical Exercises
Activity

Understanding colour mixing

Material required

White light LED torch, translucent plastic papers (gelatin 
paper) of red, green and blue colours

Procedure

yy Cover red, green and blue translucent plastic sheets 
(gelatin paper) over the white LED torchlight. 

yy Now, go to a dark room or switch off the lights and 
mix each colour with the other, and see the output or 
resultant colour generated on the wall due to mixing of 
the coloured beams of light from the torch. If you mix 
all the three colours (RGB), you get pure white light. 
The more light you add, the brighter the colour mix 
becomes. 

yy Note down the colours formed.

Notes
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Session 4: Rgb Display Mechanism

In the previous sessions, you have learnt that common 
application of the RGB colour model is the display of 
colours on a Cathode Ray Tube (CRT), Liquid Crystal 
Display (LCD), plasma display, or Organic Light Emitting 
Diode (OLED) display, such as television and computer 
monitor. You have also learnt that digital storage of an 
image requires that it should be broken down into a 
grid of tiny pixels.

Pixel
Pixel is the basic or fundamental unit of an image. One 
pixel has only one colour information. However, each 
pixel is made up of three different colour components, 
i.e., red, green and blue in different percentages. The 
value of the pixel at any point denotes the intensity of 
image at that location, and that is also known as grey 
level. In an 8 bits grey scale image, the value of the pixel 
is between 0 and 255. The value 0 means absence of 
light. It means that 0 denotes dark, which means that 
whenever a pixel has a value of 0, black colour would be 
formed at that point.

The value of a pixel at any point corresponds to the 
intensity of the light photons striking at that point. Each 
pixel stores a value proportional to the light intensity 
at that particular location. A digital colour image pixel 
is just numbers representing an RGB data value (Red, 
Green, Blue).

A cathode ray tube consists of three parts: 
the electron gun assembly, the phosphor viewing 
surface and the glass envelope. Each phosphor layer 
is responsible for one colour. The phosphors are 
deposited in the form of very small dots in a repeated 
pattern across the screen— red, green, blue and so on. 
It can produce a maximum of four to five colours. The 
red, green and blue phosphor are coated one behind 
the other in layers. If a low speed beam strikes the 
CRT, only the red coloured phosphorus is activated, 
a slightly accelerated beam would activate both red 
and green and a much more activated one would add 
the blue component also. It works on the principle 

Notes
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of combining the basic colours—  Red, Green and  
Blue (RGB).

Pixel Resolution
You must have heard about a high and low resolution 
photo. A ‘300 DPI photo’ is sometimes referred to as 
a high resolution photo. But a high resolution photo 
generally means a high pixel per inch (usually 300 or 
greater) when printed. Low resolution pictures are of 
less than 300 DPI. Thus, the more pixels per each inch, 
the better quality print you will get when you print an 
image. Resolution is a numerical digit by which the 
quality of an image can be measured. It is calculated 
as the number of pixels present per inch of an image. It 
can be defined in many ways, such as pixel resolution, 
spatial resolution, temporal resolution, and spectral 
resolution.

Each pixel on the screen is built by driving three 
small and close, yet separated RGB light sources. At 
a general viewing distance, the separate sources are 
indistinguishable, which is tricky to our eye and show 
a given solid colour. All pixels arranged together in a 
rectangular screen surface conforms the colour image.

In pixel resolution, the term resolution refers to the 
total number of count of pixels in a digital image. For 
example, if an image has A rows and B columns, then its 
resolution can be defined as A × B. Pixel resolution can 
be defined with a set of two numbers. The first number 
is the width of the picture, or the pixels across columns, 
and the second number is height of the picture, or the 
pixels across its width. We can say that the higher the 
pixel resolution, the higher is the quality of the image.

A digital camera can capture data based on the 
mega-pixel ability of its charge-coupled device (CCD). 
A digital camera has a sensor that converts light into 
electrical charges. The image sensor employed by most 
digital cameras is a charge coupled device. An 8 mega-
pixels digital camera shoots at approximately 3264 × 
2448 pixels. Monitor resolution is measured strictly by 
pixel width and height. Some common settings are 1280 
× 1024, 1920 × 1080 or 2880 × 1800.

Notes
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Check Your Progress
A.	 Fill in the Blanks

1.	 Pixel is the basic or fundamental unit of an ___________. 
2.	 A single pixel has ____________colour information.
3.	 Resolution is a ________________digit by which the 

quality of an image is measured.
4.	 Resolution is calculated as the number of _________

present per inch of the image.

B.	 Subjective Questions

1.	 Write a short note on pixel.
2.	 What is pixel resolution?

What have you learnt?
On the completion of this Session, you will be able to:

yy describe the meaning of ‘pixel’.
yy differentiate between high and low resolution.

Practical Exercises
Activity 1

Understanding photo scan resolution

Material required
Colour image scanner, Adobe Photoshop, a colour or black and 
white laser printer

Procedure
yy Scan a colour photo printed on a magazine in 50 DPI 

(dots per inch, which technically means printer dots 
per inch) and 600 DPI mode of the scanner. 

yy Now, take a printout from a colour or black and white 
printer, and observe the blurriness or sharpness of the 
picture.

yy Compare it with the original magazine photo. 
yy Write down your observations in your notebook.

Activity 2
Understanding the working of CRT monitor

Material required
A computer with Internet connection

Procedure
yy Surf the Internet and search for ‘How CRT monitor works’.
yy Study the diagram of CRT on internet.
yy Draw the diagram showing the colour electron beams 

in a CRT monitor.

Notes

Unit-1.indd   18 1/7/2021   2:10:32 PM



Colour Theory

19

Session 5: Colour Schemes

Colour schemes are logical combinations of colours on 
the colour wheel. The colour scheme is used to create 
an aesthetic feeling of style and appeal on an image. 
Colour harmony is the procedure of creating colour 
schemes, depending on how they look together.

Monochromatic Colour Scheme
‘Monochromatic’ means one 
(mono) colour (chroma). Hence, 
a monochromatic colour scheme 
is made up of hues or shades of 
one colour. The monochromatic 
colour scheme uses variations 
in lightness and saturation of 
a single colour. This scheme 
looks clean and elegant. 
Monochromatic colours go well 
together, producing a soothing 
effect. It is easy on the eyes, 
especially blue or green hues. 
You can use it to establish an 
overall mood (Figure 1.15).

The primary colours can be 
integrated with neutral colours, 
such as black, white or grey. 
The monochromatic scheme is 
easy to manage, and always looks balanced and visually 
appealing. However, when using this scheme, it can be 
difficult to highlight the most important elements. This 
scheme lacks colour contrast. It is not as vibrant as the 
complementary scheme.

Analogous Colour Scheme
The analogous colour scheme uses colours that are 
adjacent to each other on the colour wheel. One colour 
is used as a dominant colour, while others are used 
to enrich the scheme. The analogous colour scheme 
is similar to monochromatic colour scheme, but offers 
more tones. It is advisable to avoid using too many hues 
in the analogous scheme as this may ruin the harmony. 

Fig. 1.15: A view of monochromatic colour scheme

Every colour has its 
own meaning.

Johann 
Wolfgang von Goethe
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Avoid combining warm and cool colours in this scheme 
as they can destroy the present analogous situation.
Examples: Blue, blue-green, green, yellow-green, red, 
red-purple, purple, blue-purple.

Fig. 1.16: Analogous colour scheme

Complementary Colour Scheme
The complementary colour scheme consists of 
two colours that are opposite to each other on 
the colour wheel. For example, red and green are 
complementary colours, another example is blue 
and orange. This scheme looks best when you 
place a warm colour against a cool colour (Figure
1.17), such as cyan, which is a complement of 
red, can be made by mixing equal amounts of 
green and blue colour. 

This scheme is intrinsically high-contrast. When 
using the complementary scheme, it is important to 
choose a dominant colour and use its complementary 
colour for accents. 

By using one colour for the background and its 
complementary colour (Figure 1.18) to highlight the 
important elements, you will get colour dominance 
combined with sharp colour contrast.

Yellow

Green

Yellow-
Green

Orange
Yellow

Orange

Yellow Orange
Yellow

Red
Orange

Orange

Green

Blue

Violet

Blue-Green

Blue- 
Violet

Red

Violet
Blue

Violet

Violet 
Red

Fig. 1.18: Complementary colour scheme

Fig. 1.17: Placement of 
warm colour against cool in 

complementary colour scheme
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The complementary colour scheme offers stronger 
contrast than any other colour scheme and draws 
maximum attention. This scheme is harder to balance 
than monochromatic and analogous schemes, especially 
when de-saturated (less pure) warm colours are used 
(Figure 1.19).

Fig. 1.19: De-saturated colour scheme Fig. 1.20: Warm and cool colours

COOL

WARM

Warm and Cool Colours
Warm colours are made of a combination of red, yellow 
and orange. As the name indicates, they tend to make 
you think of sunlight and heat. Warm colours are vivid 
and energetic and tend to advance in space (Fig. 1.20). 
Examples are red, yellow and orange.

Cool colours are associated with cool things and give 
a calm and soothing feeling. Cool colours remind us of 
water and sky. Examples are blue, purple and green. 

White, black and grey are considered to be neutral 
colours.

Practical Exercises
Activity 1

Creating different shades of cool colours

Material required
Adobe Photoshop
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Check Your Progress
A.	 Fill in the Blanks

1.	 A colour scheme, which consists of two colours that are 
opposite to each other on the colour wheel, is known as 
________________colour scheme.

2.	 The scheme which offers stronger _________________ 
than any other colour scheme and draws maximum 
attention is known as complementary colour scheme.

3.	 When colours are made with orange, red, yellow 
and a combination of them, these colours are called 
________________colours.

4.	 When colours, such as blue, green and light purple 
are used for mixing purpose, then they are known as 
____________colours.

B.	 Subjective Questions 

1.	 Differentiate between monochromatic, analogous and 
complementary colour schemes.

2.	 Write a short note on cool and warm colours. 

What have you learnt?
On the completion of this Session, you will be able to:

yy distinguish between monochromatic, analogous and 
complementary colour schemes. 

yy describe the advantages and limitations of various 
colour schemes.

yy create colour schemes as per the requirement.

Procedure

yy Create five overlapping circles having different shades 
of cool colours (blue or green tones).

yy Create a JPG file and view the same in full screen mode 
in Adobe Photoshop. 

yy Write down the feeling you had while observing the 
circles.

yy Does the image give you peace of mind?
yy Perform a similar activity for warm colours and note 

down your observations. 

Notes
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There are three parts in any type of film production 
process, these are— pre-production, production and 
post-production. 

Pre-production
In the pre-production process, you have to define the 
message that you would like to convey to the audience,  
create a story to convey the message, decide your budget, 
decide your locations for video shooting, determine 
your video length, decide the characters, determine 
the equipment you need, and plan the timing of the 
film. Skipping any of these aspects will cause serious 
problems later in the production process. 

Pre-production in film-making, is the process in 
which after writing the concept or developing an idea, a 
story is developed into a script. In a live video film, the 
script is followed by screenplay writing. The screenplay 
is followed by cinematography (video shooting) of the 
script. This sequence of activities falls in the pre-
production phase. 

In case of an animation film, the development of a 
storyboard (also called storyboarding or storyboard 
making) is the pre-production process after  
scriptwriting. This is followed by animatic design 
and Voice Over Recording (VOR). If it is a verbal film 

2 Digital  
Photography and  
Pre-production

2
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(dialogue-based animation film), then VOR is done, else 
storyboard making is the last stage of pre-production. 
The VOR helps the animator to animate exactly what 
is required by the script. This is opposite to video film 
production, where we can shoot the actual footage, 
which may be 3−4 times the duration of the actual film 
length. It is important to note that pre-production is the 
most important process for success in planning a film  
(Figure 2.1). 

Session 1: Camera Angles and Movements

Camera angles and camera movements are combined 
to create different shots or scenes. A camera is placed 
in relation to the subject (object to be filmed) in such 
a way that the viewer perceives the subject and best 
elaborates the script or storyboard. 

Types of Camera Shots
Camera shots indicating subject 
size can be divided into Long, 
Medium and Close. 

Long shots (wide shots) show 
the subject from a distance, 
emphasising place and location, 
while a Close shot shows the details 
of the subject or character. Medium 
shots place emphasis on the 
subject, while still showing some of 
the surrounding environment.

Shots indicating placement of 
camera in relation to the subject 
can be categorised into high, 
low, eye level, bird’s-eye view, or 
worm’s-eye view.

A ‘viewpoint’ is the actual distance and angle from 
which the camera views and records the subject. It 
includes the camera’s eye level, and point of view shot 
(Figure 2.2).

In a High-angle (HA) shot, the camera is at a higher 
level than the subject and is looking down upon it. The 
high-angle shot can make the subject look smaller. While 

Fig 2.1: Pre-production stages

Pre-production

Concept
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Animatic design

Voice over recording

1
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4

Fig. 2.2: Camera angles
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a low-angle (LA) shot is taken from a lower height than 
the subject to make it look threatening, the background 
of a low angle shot will tend to be just sky or ceiling, with 
the lack of much detail for viewers. The added height 
of the object may create a feeling of fear or insecurity 
in the viewer, who is psychologically dominated by this 
figure on the screen.

In an Eye level (EL) shot, the camera is placed at the 
same level of the height as the eyes of the characters in 
the frame. The camera will be placed at approximately 
5−5½ feet from the ground. The shot has little to no 
psychological effect on the viewer. This shot is taken 
when the camera is at the level of the subject, or looking 
straight on to it.

The Bird’s-eye view shot shows a scene from the top, 
looking down directly on the subject below. Familiar 
objects viewed from this angle might seem totally 
unrecognisable at first (umbrellas in a crowd, dancers’ 
legs and heads). People can be made to look insignificant 
or ant-like (of smaller significance). Sir Alfred Joseph 
Hitchcock, an English film director and producer, and 
his admirers were fond of this style of shot (which 
created a feeling of suspense). Hitchcock is regarded as 
one of the most influential filmmakers in the history of 
cinema.

Camera movements
A director of the film uses various camera shots for 
telling a story— as a series of cuts, going from one shot 
to another. There are seven basic methods of camera 
movements.

Pan
It is a camera movement, in which a scene is shot with 
horizontal movement. The camera is placed on a tripod, 
which is fixed, i.e., a stationary axis point, as the camera 
is turned, following a moving object, which is kept in 
the middle of the composed frame (Figure 2.3).

Tilt
A movement, wherein a scene is shot vertically up and 
down, similar to a horizontal ‘pan’ (Figure 2.4).

Fig. 2.4: Camera tilt angles

Fig. 2.3: Camera pan angles

PAN

TILT
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Dolly shots
Dolly shot involves laying a track for the camera which 
follows the object, hence it is also known as ‘tracking’ 
shot. Thus, sometimes it is also called as ‘tracking’ or 
‘trucking’ shots (tracking the moving object). The camera 
is placed on a moving vehicle and moves parallel to the 
action, often following a moving figure or object.

It is, therefore, a shot taken from a moving dolly 
(a platform with a set of wheels). The camera can be 
mounted on a car, plane, or even a shopping trolley, 
or revolving wheelchair. Dolly shot may be a way of 
recording movement, the journey of a character, or 
moving in a direction from a long shot to a close-up of 
an object or subject, which may, gradually, focus on 
the audience or a particular object or character (Figure 
2.5). When the camera moves towards the subject, it is 
known as ‘dolly in.0’, and when it moves away from the 
subject, it is known as ‘dolly out.0’.

Fig. 2.5: Dolly shot

Crane shots
It is a moving shot taken from a crane (a mechanical 
arm which carries both camera and camera operators). 
A crane (or ‘jimmy jib’) is a large heavy equipment 
(Figure 2.6), which is used for moving the camera at 
very high or very low level, without the camera-person 
going closer to the object — the whole arm of the jimmy 
jib can move up, down, left, right, driving in on action, 
or moving diagonally out of it. The camera-person and 
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Aerial shot
An aerial shot is a shot taken from 
a flying object such as, helicopter 
or a drone camera (Figure 2.7).

Handheld shots
In handheld shot, the camera 
is held in the camera operator’s 
hands, as opposed to being 
mounted on a tripod. They can 
make the audience feel as though 
they are actually part of a scene, rather than observing 
it from a detached far away position.

Common Photography Terms
Some of the common photography terms related to 
camera are given below.

Zoom lens
A zoom lens has a mechanism that changes the 
magnification of an image in a camera. While a prime 
lens (also known as fixed lens) has a fixed focal length, 
a zoom lens has a variable focal length. Zoom lenses 
have two specifications that represents two extremes of 
the zoom range. For example, 70–200 mm range means 

Fig. 2.7: A drone with a camera for taking aerial shots

camera are counter-balanced by a heavy weight, and a 
jib operator needs to take care of the safety of self and 
others while handling the equipment.

Fig. 2.6: A camera with a crane
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that the lens may act as a 70 mm focal 
length lens, a 200 mm focal length lens and 
everything in-between will have variable 
aperture ranges. It is the photographer 
who can get a ‘close-up’ shot while being 
at some distance from the subject. Zoom 
lens can make an object appear closer or 
farther, either quickly (a smash zoom) or 
slowly, without moving the camera even 
an inch, thus, saving time and hassle. 

Zoom lenses are extensively used by directors, who try 
to give the impression of movement and excitement in 
a scene while it actually does not exist. One must use 
zoom lenses with caution and on a tripod to avoid hazy 
pictures (Figure 2.8).

Aperture
Aperture is the size of the opening in lens (Figure 2.9). 
Think of the lens as a window—a wide open window 
that lets in more light, while a little open (largely closed) 
window lets in less light. A wide open aperture will allow 
more light to fall on an image for a brighter photo, while 
a smaller aperture lets in less light. 

Fig. 2.9: Aperture size

f/1.4

f/5.6

f/2

f/8

f/2.8

f/11

f/4

f/16

Fig. 2.8: Types of zoom lenses 

Aperture is measured in f-stops. The aperture of a 
lens is the diameter of the open circle or diaphragm 
inside a lens. This diameter is expressed as f-number, 
such as f/1.4 or f/16. The lower the f-number, the wider 
the aperture. The wider the aperture, the more light 
gets into the sensor. A small f-stop like f/1.8 means 

A diaphragm of a camera 
consists of overlapping 
metal blades (the iris) that 
open and close to change 
the size of the opening, 
which is required for 
controlling the aperture 
and depth of field of an 
image.
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a wide opening, while a large f-stop like f/22 is a very 
narrow opening. Aperture is one of the three camera 
settings that determines an image exposure, or how 
light or dark it is. Aperture also affects how much of 
the image is in focus—wide apertures result in creamy, 
unfocused background, while narrow ones keep the 
image sharp.

Aspect ratio
It is the ratio of the projected image’s width to its 
height. A 1:1 ratio means that an image’s width and 
height are equal, thus creating a square. A 6 × 4 inch 
image has an aspect ratio of 3:2, which is there in 35 
mm Film DSLR Cameras and Smartphones. A 4:3 ratio 
is used for television displays, computer monitors, 
and digital cameras. The 16:9 ratio is mostly seen on 
presentation slides, computer monitors, or widescreen 
HDTVs (Figure 2.10).

Fig. 2.10: Aspect ratio in photography

5:4
Computer 
Displays

16:9
HDTV,
Widescreen SDTV 
and Smartphones

2.35:1

Cinemascope

1.85:1

Cinema Film (US)

4:3
SDTV/Video 
Computer 
Displays

3:2
35 mm 
Film DSLR 
Cameras and 
Smartphones

16:10
Widescreen 
Computer 
Displays and 
Smartphones

 

Burst mode
You can take photos one at a time, or can turn 
the burst mode on and the camera will continue 
snapping photos as long as you hold the button 
down, or until the buffer is full. Burst speed differs 
based on what camera you own, some are faster 
than others. It depends on how fast it occurs and 
it is written in ‘fps’ or frames (pictures) per second 
(Figure 2.11).

Fig 2.11: An example of burst mode
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Depth of field (DoF)
Depth of field refers to how much of an image is in focus. 
The camera will focus on one distance, but there is a 
range of distance in front and behind that point that 
stays sharp — this is known as depth of field. Portraits 
often have a soft, unfocused background — this is a 
shallow depth of field. Landscapes, on the other hand, 
often have more of  the image in focus — this is a large 
depth of field  (Figure 2.12).

Fig. 2.12: Depth of field

Digital and optical
Digital and optical are important terms to understand 
when shopping for a new camera. Digital means the 
effect achieved through software, and not the physical 
parts of a camera. Optical is always better than digital. 
These terms are, usually, used when referring to zoom 
(in a compact camera), as well as image stabilisation 
(Figure 2.13).

Fig. 2.13: A picture explaining digital versus optical zoom concept

Notes
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Exposure
An image is created when the camera sensor (or film 
strip) is exposed to light. Exposure is how light or dark 
an image is. A dark photo is considered underexposed 
or not exposed to enough light. A light photo is 
overexposed or exposed to too much light. Exposure is 
mainly controlled through aperture and shutter speed. 
The shutter speed or exposure time is the length of 
time when the digital sensor in the camera is exposed 
to light. It is also the time when a camera shutter is 
open while taking a photograph. It is indicated as f-stop 
(Figure 2.14). Aperture controls the depth-of-field, 
which is what is in focus in the picture. Aperture can 
be used to draw attention to one subject by blurring the 
background with a wide aperture (Figure 2.15).

Fig. 2.15: Use of aperture to draw attention to one subject 

Fig. 2.14: Wide to narrow 
aperture

Exposure compensation
Exposure compensation is a way to tell the camera that 
you would like the exposure to be lighter or darker. It 
is measured in stops. A single stop represents doubling 
of the amount of light hitting the sensor. Exposure 
compensation gives you the ability to change the shutter 
speed while staying at the same aperture you have 
originally set. In Aperture (A) Priority mode, exposure 
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compensation changes the shutter speed, whereas 
in Shutter (S) Priority mode, exposure compensation 
changes the size of your aperture. In Programme (P) 
mode, exposure compensation changes the shutter 
speed (Figure 2.16).

Fig. 2.16: Exposure compensation

Exposure bracketing
In exposure bracketing, the camera is set to take multiple 
pictures in a row, with the first at normal exposure, the 
next one underexposed, and the final one overexposed 
(Figure 2.17). 

Fig. 2.17: Exposure bracketing

Notes
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Focus
When your eyes focus on a closer object, the objects far 
away will appear blurry. ‘Focus’, a common photography 
term, has the same meaning. Something that is in focus 
is sharp, while an object that is out-of-focus, is not 
sharp. Different focus areas determine if the camera is 
focusing on multiple points or one user-selected point. 
An image that is completely sharp is said to be in-
focus. An image that’s completely blurry is said to be 
unfocused. The icon usually used for focus is shown in 
Figure 2.18.

Histogram
A histogram is a graph that shows frequency of anything. 
Usually histogram have bars that represent frequency 
of occurring of data in the whole data set. The image 
is made up of millions of pixels and each pixel has a 
value representing its colour. The pixel’s brightness is 
derived from this value. A histogram is a graph, which 
you can see on your camera, and it tells you about 
the distribution of light in an image. The scale of the 
histogram goes from left to right i.e. from 0% brightness 
(black) to 100% brightness 
(white). A histogram has two 
axis— the x axis and the y 
axis. The x axis contains the 
event, the frequency of which 
you have to count, and the y 
axis contains frequency.

The different heights of 
bar show different frequency 
of the occurrence of data. 
The x axis shows the grey 
level intensities and the y 
axis shows the frequency 
of these intensities. If the 
chart peaks towards the left, 
the image has a lot of dark 
hues. If it peaks to the right, 
the image has a lot of light hues. If those peaks are 
cut off at the edges, the image is underexposed (on the 

Fig. 2.18: Icon of Focus

Figure 2.19: A view of histogram
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left edge) or overexposed (on the right 
edge). It is, therefore, used in adjusting 
the contrast of an image and equalise 
an image (Figure 2.19). A histogram 
is something that the beginners must 
learn after understanding manual 
modes.

Hot shoe
Hot shoe (Figure 2.20) is the slot at 
the top of a camera for attaching hot 
shoe flash or other accessories. The 

flash unit creates a circuit between the shoe and the 
contacts. Once the circuit is complete, the flash will fire 
as the shutter is pressed.

ISO (International Organisation for 
Standardisation)
In digital photography, ISO measures the sensitivity 
of the image sensor or film inside the camera. This 
measure of sensitivity is expressed as ISO speed. The ISO 
speed of film or digital camera sensors is derived from 
standards adopted by the International Organisation for 
Standardisation. For example, an ISO of 100 means the 
camera is not very sensitive for shooting in daylight. An 
ISO of 3200 means the camera is very sensitive to light. 
Therefore, a camera with higher ISO can be used for 
getting shots in low light. The trade-off is that, images 
at high ISOs appear to be grainy and have less detail. 
ISO is balanced with aperture and shutter speed to get 
a proper exposure.

Cameras have different range of ISO values that you 
can use. A common set of ISOs are as follows:
yy ISO 100 (low ISO)
yy ISO 200
yy ISO 400
yy ISO 800
yy ISO 1600
yy ISO 3200
yy ISO 6400 (high ISO)

Fig. 2.20: Hot shoe
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Long exposure
Long exposure refers to an image exposed to light for a 
long time or the one that uses a long shutter speed. This 
technique is useful for shooting still objects in low light. 
Long exposure night photography can produce better 
results. 

Manual mode
Manual mode allows a photographer to set the exposure 
instead of having the camera do it automatically. In 
manual mode, you choose the aperture, shutter speed 
and ISO, and those choices affect how light or dark an 
image will be. Semi-manual modes include aperture 
priority (where you only choose the aperture), shutter 
priority (where you only choose the shutter speed) and 
programmed auto (where you choose a combination of 
aperture and shutter speed together instead of setting 
them individually). Manual mode thus allows you 
to select an aperture value and shutter speed value 
manually.

Image noise
Image noise is a random variation of brightness or 
colour information in images. Images will show more 
noise in the shadow areas than in lighter parts. Images 
taken at high ISOs have a lot of noise, so it is best to use 
the lowest ISO. There are softwares which can be used 
for noise reduction. 

RAW
RAW is a file type and is considered as the best form of 
image file, since it does not process the picture, leaving 
total control of editing to the user. RAW file size is much 
larger than jpeg files, but is smaller than tif files.

Rule of thirds
‘Rule of thirds’ is a compositional rule, which is applied 
by imagining that the image is divided into three 
parts, both horizontally and vertically. Often the most 
interesting compositions result in placing the subject 
on one of the intersections of those imaginary lines, 

Notes
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instead in the centre of the photo. 
It is one of the most well-known 
rules of photography as it forms 
the basis for balanced and creative 
shots (Figure 2.21). 

Shutter speed
Shutter is that part of the camera, 
which opens and closes to allow 
light in and take a picture. Shutter 
speed refers to how long the 
shutter stays open. Shutter speed 

is typically measured in fractions of a second. The 
longer the shutter stays open, the more the light is let 
in. But anything that moves while the shutter is open 
will become blur, and if the entire camera moves while 
the shutter is open, the whole image will be blurry. That 
is why, tripods are necessary for longer shutter speeds.

Shutter release
It is the push button that you press on the camera to 
take a picture. When the button is pressed, the shutter 
of the camera is released, so that it opens to capture a 
picture, and then closes, allowing an exposure time as 
determined by the shutter speed setting.

Time lapse
Time lapse is a video created by stitching several photos 
of the same thing taken at different times together. Time 

lapse is not to be confused with long 
exposure, which is a single image 
with long shutter speed.

Viewfinder
It is the hole from where one looks 
through to take a picture. Some 
digital cameras do not have this and 
have a screen instead. But all Digital 
Single Lens Reflex Cameras (DSLRs) 
and most mirror-less cameras use 
viewfinders (Figure 2.22).

Fig. 2.22: Viewfinder

Fig. 2.21: Application of Rule of Thirds
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White balance
Your eyes automatically adjust to different light 
sources but a camera cannot do that. That is why, 
sometimes, when you take an image, it looks blue 
or yellow. White balance is a camera setting that 
adjusts the colour balance of light (Figure 2.23). All 
digital cameras have an auto white balance setting 
that analyses the colours in a scene and neutralises 
them automatically. But like any automatic setting, 
it is not always accurate. This is why cameras also 
offer manual white balance presets that you can 
choose to match the conditions. You can use a pre-
set based on what light you are shooting in, like 
daylight or tungsten.

Check Your Progress
A.	 Fill in the Blanks

1.	 A ________________ shot is one in which the camera is 
physically at a higher level than the subject. 

2.	 A ________________ shot is taken from a lower level than 
the subject and has the power to make the subject look 
powerful or threatening. 

Fig. 2.23: White balance settings
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Practical Exercises
Activity 1

Understanding camera angles

Material required

DSLR Camera

Procedure

yy Click photos with different camera angles using a DSLR 
camera and observe the differences.

yy To begin with you may click horizontal or landscape 
photos, vertical or portrait photos, etc. 

yy Now try the different camera angles, such as high level, 
low level, bird’s eye view and eye level. 

yy Make a note of your observations and include the 
photos in your portfolio.
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3.	 An ________________ shot is taken at the level of the 
subject. Here, the camera looks straight at the subject.

4.	 The ________________ view shot shows a scene from the 
top level, looking down directly on the subject below.

5.	 A ________________ shot makes the object clicked seem 
smaller and less significant.

6.	 In ________________ camera movement, a scene is shot 
with horizontal movement. 

7.	 In ________________ camera movement, a scene is shot 
vertically up and down, similar to a horizontal pan.

8.	 In ________________ shot, the camera moves alongside 
the subject it is recording.

9.	 A ________________ lens has a mechanism that changes 
the magnification of an image. 

10.	 Aperture is the ________________ of the opening in the 
lens.

11.	 Depth of field is a term in photography that refers to 
how much of the image is in ________________. 

12.	  ________________ is how light or dark an image is.
13.	  ________________ shoe is the slot at the top of a camera 

for adding accessories.
14.	 The ISO determines how sensitive the camera is to  

________________. 
15.	 A long exposure is an image that has been exposed to 

light for a long time or uses a long ____________ speed.

B.	 Subjective Questions

1.	 Write short notes on the following:
(a)	 Aperture
(b)	 Exposure 
(c)	 Focus
(d)	 Depth of field

2.	 What is the difference between crane shot and aerial 
shot?

What have you learnt?
On the completion of this Session, you will be able to:

yy describe the pre-production steps;
yy identify the various types of camera shots and camera 

movements;
yy describe the purpose of Zoom lens;
yy explain aspect ratio in photography; and
yy describe the meaning of various terms related to 

exposure in photography.

Notes
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Session 2: Pre-production

Pre-production is a phase that involves development of 
ideas and planning prior to the process of production. 
In an action movie, it is the period before the filming 
actually starts. In an animation film, it is the period 
before real animation takes place.

The success of a project lies in ‘planning’. This 
Session gives an overview of the different steps involved 
in the pre-production process and how each step helps 
to develop a roadmap on which to base the further 
production stages. Although there is a general sequence 
of events in pre-production, it is normal for various 
stages to be revisited more than once. Having the 
insight, discipline, and patience to recognise and make 
changes when appropriate, is a key quality for anyone 
working on animation.

Storyboard
A ‘storyboard’ is a sequence of drawings that is used 
to help communicate ideas and messages. It includes 
a series of drawings and pictures with some directions 
and dialogues. It describes the events and scenes, 
often accompanied by text notes, describing what is 
occurring in the scene. Storyboards may also include 
lighting and camera movements to describe the frame 
in detail. The idea of storyboarding was developed at 
the Walt Disney Studio during the early 1930s. The first 
complete storyboards were created for the 1933 Disney 
short movie ‘Three Little Pigs’ (The Story of Walt Disney, 
Henry Holt, 1956).

A film storyboard is a series of frames with drawings 
in the sequence of events taking place in the film. It 
helps film directors and cinematographers to visualise 
the scenes and find basic requirements and potential 
problems before the shooting of the film. A detailed 
storyboard may also help in estimating the cost of the 
overall production of the film.

Character Design
Character design includes developing the appearance 
and features of characters in an animation (Figure 2.24). 
Often, an actual model is produced using modeling 

Notes
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clay in order to get a better idea of the appearance of a 
character. 

Fig. 2.24: Character designing 

Model sheets
Model sheets are drawings of posed cartoon or comic 
spip characters that are created to provide a reference 
template for production of art or comic book or 
video. ‘Model sheets’ are produced to help animators 
work on the appearance of characters. These sheets 
help animators to understand the character details. 
‘Character line-up sheets’ are also produced to compare 
the scale of the characters against one another.

Expression sheets
Expression sheets serves as a guide for the facial 
expressions of a character, such as smile, laugh, 
sad, shocked, startled, sleepy, alert, thoughtful and 
concerned (Figure 2.25).

Fig. 2.25: Expression sheet 

Animatics
Animatics are used for pre-visualising the film before 
the actual production starts. You may consider it as 
storyboards that are brought to life using animation and 
sound. It is made up of individual frames taken from 
the storyboard. Each frame depicts a certain key point 

Notes
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of a scene or movie, which is accompanied by audio, 
sound effects and music. 

Practical Exercise
Activity 1

Make a storyboard.

Material Required

Storyboard sheets or chart papers, thumbnail sheets, board, 
writing material.

Procedure

yy Make a list of the main events of the story.
yy Arrange them in the order in which the story will be told 

through the storyboard. 
yy Draw or pick scenes that show the plot developing 

from start to finish. Scenes could be about plot twists, 
showing different settings, character development, etc. 

yy Show the turning points of the scenes as it brings about 
curiosity amongst the learners. 

yy Write a description of what each cell will show so that it 
can be converted into dialogue. You might want to have 
a cell that shows a conversation between two characters. 
You can show characters fighting, smiling, or moving. 
Show the background behind the characters.

yy Also mention the composition for each cell, which may 
include lighting,  colour palette, etc. Props (objects in 
the frame) and special effects may also be included. 

yy You may also mention the angle from which the camera 
will be shooting (high, low, dolly shot, wide shot, tracking 
shot, etc.)

yy Show your storyboard to the teacher and take feedback 
for improvement. 

yy You may use the pictures given below to start your 
storyboard. 

Notes
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What have you learnt?
On the completion of this Session, you will be able to:

yy demonstrate the knowledge of the process of pre-
production.

yy describe the importance of storyboard in pre-production 
process.

yy identify the elements of a story.
yy generate ideas for drawing characters for a storyboard.

Check Your Progress
A.	 Fill in the Blanks

1.	 Pre-production is a phase that involves further 
developing of ideas and planning prior to the process  
of ______________.

2.	 A ______________ is a sequence of drawings that is used 
to help visualise the animation and to communicate 
ideas clearly.

3.	 A ______________ contains key events and scene changes 
in the animation, and is often accompanied by text 
notes, describing what is occurring in a scene, such as 
camera movements. 

4.	 Character ______________ involves developing the 
appearance and features of characters in an animation.

5.	 ______________ sheets are produced to help animators 
work on the appearance of characters.

6.	 An animatic is a timed moving version of the _________. 

B.	M atch the Columns

Column A Column B
1. Storyboarding (a)	 It is a timed moving version 

of the storyboard, made up of 
individual frames taken from the 
storyboard.

2. Model sheets (b)	 These are precisely drawn groups 
of pictures that show all of the 
possible expressions that a 
character can make.

3. Animatics (c)	 It is a sequence of illustrations 
and images for the purpose of 
visualising animation or a motion 
picture.

C.	 Subjective Questions 

1.	 Write a short note on character design and animatic.
2.	 Differentiate between storyboard and animatic.

Notes
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Adobe Photoshop is a computer application software 
used to edit and manipulate digital images. It helps in 
creating and manipulating documents and files using 
various elements, such as panels, bars and windows. An 
arrangement of these elements is called a ‘workspace’. 
On starting an Adobe Creative Suite component, the 
default workspace is seen, which can be customised 
for the tasks to be performed there. For instance, you 
can create one workspace for editing and another for 
viewing, save them and switch between them as you 
work. You can restore the default workspace at any 
time by choosing the default option on the ‘Window > 
Workspace’ menu.

Texture painting tools are a means of adding the final 
finishing details. The brushes are intuitive, customisable 
and have the potential for producing realistic 3D models. 
Even the default brush sets included in the software 
package offer a variety of high-quality textures. These 
tools work together and allow one to paint textures 
directly from an external image onto one’s model.

The ‘Tool’ panel (called the ‘tool palette’ in Photoshop) 
contains tools for creating and editing images, artwork, 
page elements, and so on. Related tools are grouped 
together.

3 Drawing and 
Painting using Adobe 

Photoshop

3
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The ‘Control’ panel (called the ‘option bar’ in Photoshop) 
displays options for the currently selected tool.

On starting Photoshop, the ‘tool palette’ appears on 
the left of the screen. Some tools in the palette have 
options that appear in the context-sensitive option 
bar. These include tools that one can use for typing, 
selecting, painting, drawing, sampling, editing, moving, 
annotating and viewing images. Other tools allow one to 
change the foreground and background colours, go to 
Adobe online and work in different modes.

Digital painting is a way of creating an art object digitally. 
It is a technique for making digital art on computer. It 
refers to a computer graphics software that uses a virtual 
canvas and a virtual painting box of brushes, colours and 
other supplies. The virtual box contains many instruments 
that do not exist outside the computer, and give a digital 
artwork a different look and feel from an artwork that is 
made using the traditional way.

Session 1: Introduction to Adobe Photoshop 
Adobe Photoshop can be used to create images from 
editing and manipulation of the existing images. 
Photoshop skills are useful and can help in doing jobs 
related to animation. The common features of the Adobe 
Photoshop are workspace, layers, smart objects, blend 
modes, selection techniques, filters and many other 
necessary features that you would be using.

When you first open Photoshop, you have a blank 
working space with various menus. Let us now look at 
some of the important features of an Adobe Photoshop 
that you can use to edit the image. 
yy Menu bar (seen horizontally at the top of the screen) 

shows the File, Edit, Image, Save as and other menus 
that give you access to a variety of commands, 
adjustments, and panels.

yy Options bar (underneath the menu bar) displays 
options for the tool you are currently working with.

yy Tools panel (on the left of the screen) contains 
tools for editing images and creating artwork. You 
can access related tools in a group by clicking and 
holding a tool in the panel.

Notes
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yy Panels (on the right) include Colour, Layers, 
Properties, and other panels that contain a variety of 
controls for working with images. 

yy Document window (in the middle) displays the file 
you are currently working on.

Fig. 3.1: Features of Adobe Photoshop 

1. Menu Bar 3. Adobe Bridge shortcut button

4. Palette Wall

6. Floating    
    Palettes

2. Tool Options Bar

5. Toolbox

Open Images or Create New Images
Once the programme starts, one needs to open an 
existing file or create a new file in order to create an 
image. This can be done by clicking at the menu bar 
and selecting New option or pressing Control key and N 
together.

In the menu bar, choose File > Open to open an 
existing image.

In the menu bar, choose File > New to create a new 
image.

Saving a File
You can save your image in Photoshop (.psd) format. 
Saving in JPEG (.jpg) or PNG (.png) format will save it 
as a standard image file that can be shared and opened 
by other programmes.
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Save image: Choose File > Save or File > Save As.
Close image: Choose File > Close.

Choose Dimension
One of the several options available is for setting the 
dimensions of one’s canvas or work area. You can use 
preset size (such as 8.5”×11”, A-4 size), custom size 
(using the height and width controls), or clipboard  
option (which will set the canvas size to the default 
dimension stored in one’s computer).

Choose resolution
One may want to set a resolution for an image, based 
on how one intends to use it. The resolution determines 
how many pixels will be in one square inch of the image. 
The more the number of pixels in an inch, the more 
detailed the image will be.

A higher number of pixels per inch will result in a 
larger image and file size. Larger files will require larger 
amount of memory to process the data or image. These 
files will also take longer time to upload or download.

The standard resolution for websites is about  
72 pixels per inch, while the standard print resolution 
is about 300 pixels per inch. One can set the resolution 
the way one wants but the user must be aware that 
using a resolution less than 300 for print will make an 
image look less sharp and blurred. Using a resolution 
above 72 pixels per inch on the web will make the image 
take longer to upload or download.

Choose colour mode
Depending on the type of output media (print, display 
or electronic media), the colour mode of an image will 
need to be changed. This determines how the colours 
will be calculated and displayed. This is a setting which 
can be changed after the image has been created. 

You have already learnt that RGB (Red, Green and 
Blue) is the mostly used colour mode. It is appropriate 
for images that will be viewed on computer. Since it uses 
8 Bits channel individually to store the colour value 

Notes
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associated with every pixel, an RGB image is a 24 Bits 
image, i.e., 8 Bits × 3 channels (of RGB) = 24 Bits image. 

CMYK (Cyan, Magenta, Yellow and Black) is another 
common colour mode. It is best used for images that 
will be printed as this mode is used by printers to 
render colours to images. Since it uses 8 Bits channel 
individually to store the colour value associated with 
every pixel, a CMYK image is a 32 Bits image, i.e., 8 
Bits × 4 channel (of CMYK) = 32 Bits image.

An exception to this is colour printing from a digital 
printing lab (photo printing lab). This printing machine 
works on the RGB mode. Hence, to take colour print 
from a digital photo lab, we need to create our graphics 
in RGB mode only. A colour laser printer, offset printing 
machine and flex printing machine prints in the CMYK 
colour mode.

Grayscale is the third most common option. Grayscale 
images range from black to white with many shades of 
grey in between. It is useful only for creating images 
which will be printed in the grayscale. It uses only two 
colours — black and white. A bit is basically a binary 
on-off switch. And each bit in binary is analogous to a 
‘stop’ when we talk about light measure. Each stop of 
light you add to your scene doubles the amount of light, 
and so with each bit you add to a number you get twice 
the total number of potential values. 1 bit is 2 values, 
and is pure black and white, 2 bit is 4 values; black, 
white and a couple of shades of grey, 3 bit is 8 values, 4 
bit is 16, and so on. By the time we reach 8-bit, we have 
256 values (28 = 256) i.e., shades of grey colour ranging 
from black to white. 

With any colour mode, the higher the number of 
bits, the more is the number of colour shades that will 
be displayed. Bit depth or colour depth specifies how 
much colour information is available for each pixel 
in an image. With high colour depth or colour bit, we 
get more visually appealing features like gradient and 
transparencies. Increasing the bits will also increase 
the file size. Therefore, use a higher number of bits only 

Notes

Unit-3.indd   47 1/20/2021   12:44:16 PM



48

Texturing Artist — Class XI

when necessary. Table 3.1 shows the number of colours 
or colour shades available and their common names.

Table 3.1

Bit 
Colour

No. of colours Resolution or Common Name for Video 
Display Mode

1 2 Monochrome
2 4 Colour Graphics Adapter (CGA)
4 16 Enhanced Graphics Adapter (EGA)

8 256 Video Graphics Array (VGA)

16 65,536 Extended Graphics Array XGA, high colour

24 16,777,216 Super VGA (SVGA, true colour)

32 16,777,216 + transparency Red, Green, Blue, Alpha (RGBA)

48 281 trillion

Choose Background
Start with a transparent background, as it will make it 
easier to achieve most effects. Create every other image 
on a separate layer above the background. 

Practical Exercises
Activity 1 

Understanding the size of RGB image in Adobe Photoshop

Material required

Computer, Adobe Photoshop software

Procedure

yy Create digital graphics in Adobe Photoshop by opening 
a canvas of 1024 × 768 pixels; resolution: 150 pixels per 
inch; Colour mode: RGB.

yy Import three images from ‘clipart’ gallery and mix 
these images and create a JPG file. View the file size in 
Windows Explorer. 

yy Write down the file size of this RGB graphics file with 
JPG file format in Kilo Byte (KB) or Mega Byte (MB).

Activity 2 

Understanding the size of CMYK image in Adobe Photoshop

Material required

Computer, Adobe Photoshop software
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Procedure 

yy Create digital graphics in Adobe Photoshop by opening 
a canvas of 1024 × 768 pixels; resolution: 150 pixels per 
inch; Colour mode: CMYK.

yy Import three images from ‘clipart’ gallery, and mix these 
images and create a JPG file.

yy View the file size in Windows Explorer. 
yy Write down the file size of this CMYK graphics file with 

JPG file format in Kilo Byte (KB) or Mega Byte (MB). 
yy Which file do you find larger— RGB Mode graphics file 

or CMYK mode graphics file?
(Note: The CMYK mode graphics file will be larger in size as compared 
to RGB mode file as CMYK is a 32 Bits image with 4 colour channels of 
8 Bits each (4 × 8 Bits = 32 Bits image), while the RGB mode graphics 
file is a 24 Bits image with 3 colour channels of 8 Bits each (3 × 8 Bits 
= 24 Bits image).

Check Your Progress
A.	 Match the Columns

Column A Column B

1. 24 Bits image (a) RGB

2. 32 Bits image (b) True colour

3. 24 Bits colour (c) High colour

4. 16 Bits colour (d) CMYK

What have you learnt?
On the completion of this Session, you will be able to:

yy demonstrate the basic knowledge of the application of 
software for creating images.

yy open a new file in Adobe Photoshop.
yy choose dimension, resolution, colour mode and 

background in Adobe Photoshop.

Notes
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Session 2: Drawing and Painting Tools

Adobe Photoshop provides tools for painting and editing 
the image colour. The Brush tool and the Pencil tool 
works like traditional drawing tools applying colour 
with brush strokes. The Brush tool supports a number 
of different brush tips that you can choose from the Tool 
Options panel. Eraser tool, Blur tool, and Smudge tool 
modify the existing colours in the image. 

When you start Photoshop, the Toolbar, or the Tools 
panel appears on the left of the screen.

Toolbar
The Toolbar (also known as the Toolbox or the Tools 
panel) is the place which holds tools for making  
selection, cropping an image, editing and retouching, 
and much more. Let us now learn about the uses and 
applications of some of the tools.

Move tool (Keyboard: V)
The move tool lets the user move objects in a given layer 
around the Photoshop canvas. To use it, click anywhere 
on the canvas and drag. As you drag, the layer will 
move with the mouse. The move tool icon is shown in  
Figure 3.2. 

Marquee (Keyboard: M)
Marquee lets the user select a part of the canvas in a 
specific shape. By default, one gets a rectangular or 
a perfect square shape, if one presses Shift key while 
selecting. However, one can also select in the shape of an 
ellipse or a circle pressing the Shift key while selecting. 
The icons used for marquee are shown in Figure 3.3. 

Lasso (Keyboard: L)
Lasso is a free-form selection tool that lets the user drag 
around the canvas and select anything the lasso area 
covers. By this tool, one can have access to polygonal 
and magnetic lasso. Polygonal lasso lets the user 
select by clicking around on the canvas and creating 
points, while magnetic lasso works the same way as the 
regular lasso, but it tries to detect edges for the user 
and automatically snaps to them. The icon for lasso is 
shown in Figure 3.4. 

Fig. 3.2: Icon for Move tool

Fig. 3.3: Icons for marquee

Fig. 3.4: Icon for Lasso
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Magic wand (Keyboard: W)
The magic wand tool allows you to select an area of 
an image based on its colour. This tool can be used 

to remove backgrounds from 
photos. The icon for magic 
wand is shown in Figure 3.5. 

Crop tool (Keyboard: C)
The crop tool is used to crop 
pictures. You can specify the 
exact size and constrain the 
crop tool to those proportions, 
or can just crop the picture to 

any size you please. The icon for crop tool is shown in 
Figure 3.6. 

Eyedropper (Keyboard: I)
The eyedropper tool lets the user click on any part of the 
canvas and take a sample of a colour and drop it at a 
specific point. The eyedropper will change the foreground 
colour to the colour it samples from the canvas.

The icon for eyedropper is shown in Figure 3.7. 

Healing brush (Keyboard: J)
The healing brush lets one take the sample from a 
part of a photograph and uses it to paint over another 
part. Once the user is done, Photoshop will examine 

the surrounding areas and 
try to blend what the user 
has painted in with the rest 
of the picture. The icon for 
healing brush is shown in 
Figure 3.8. 

Paintbrush and pencil (Keyboard: B)
Paintbrush is a tool that resembles a paintbrush. The 
pencil tool resembles a pencil. The paintbrush, however, 
can be set to different kinds of brushes. One can paint 
using standard paintbrush and airbrush styles, or even 
with leaves and other shapes. The icon for paintbrush 
is shown in Figure 3.9. 

Fig. 3.5: Icon for magic wand

Fig. 3.6: Icon for crop tool

Fig. 3.7: Icon for eyedropper

Fig. 3.9: Icon for paintbrush

Fig. 3.8: Icon for healing brush
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Clone stamp (Keyboard: S)
The clone stamp tool allows the user to duplicate a 
part of an image. It involves setting a sampling point in 
the image which is used as a reference to create a new 
cloned area. Like healing brush, clone stamp lets the 
user sample a part of a photograph and use it to paint 
over another part.

The icon for clone stamp is shown in Figure 3.10. 

History brush (Keyboard: Y)
History brush lets one paint back in time. Photoshop 
keeps track of all the moves that the user makes (50 
by default). The History Brush allows you to restore 
parts of an image to an earlier history state by painting 
over them. Say, you brightened up the entire photo but 
wanted to make a certain area look like it did before 
you brightened it, so you can use the history brush and 
paint that area to get the previous darkness. The icon 
for history brush is shown in Figure 3.11.

Eraser tool (Keyboard: E)
The eraser tool changes pixels to either the background 
colour, or to transparent. It erases pixels as you drag 
it across the image. The background eraser tool allows 
you to remove the background colour from an image or 
layer. The magic eraser tool erases all the colours within 
a set tolerance. The icon for eraser tool is shown in  
Figure 3.12.

Paint bucket tool and gradient tools (Keyboard: G)
The paint bucket tool lets one fill in a specific area with 
the current foreground colour. The gradient tool will, 
by default, create a gradient that blends the foreground 
and background tool colour. The icon for paint bucket 
tool is shown in Figure 3.13.

Blur, Sharpen and Smudge tools (Keyboard: None)
All three tools act like paintbrushes, but each has a 
different impact on a picture. The ‘Blur’ tool will blur the 
area where you paint, the ‘Sharpen’ tool will sharpen it, 
and ‘Smudge’ tool will smudge the area all around the 

Fig. 3.10: Icon for clone stamp

Fig.3.11: Icon for history brush

Fig. 3.12: Icon for eraser tool

Fig. 3.13: Icon for paint 
bucket tool

Fig. 3.14: Icons for blur, 
sharpen and smudge tools
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canvas. The Smudge tool is useful in drawing, creating 
nicely blended colours, and creating wisps and smoke 
that you can add to photos. The icons for blur, sharpen 
and smudge tools are shown in Figure 3.14.

Dodge, Burn and Sponge tools (Keyboard: O)
The Burn, Dodge and Sponge tools are paintbrush-like 
tools that manipulate light and colour intensity. The 
Burn tool can make areas in your photo darker. The 
Dodge tool can make them lighter. The Sponge tool can 
saturate or de-saturate colour in the area you paint 
with it. These are all useful tools for photo touch-ups. 
The icons for dodge, burn and sponge tools are shown 
in Figure 3.15.

Pen tool (Keyboard: P)
The pen tool is used as a path creator. It is required 
for designing, selecting smooth surfaces or preparing 
layouts. The pen tool is used for drawing vector graphics. 
The icon for pen tool is shown in Figure 3.16.

Type tool (Keyboard: T)
The type tool allows one to type horizontally. Tools 
hidden beneath the horizontal type tool will let 
one type vertically, and also create horizontal and 
vertical text masks. The icon for type tool is shown in  
Figure 3.17

Path tool (Keyboard: A)
A path is a line that goes from one point to another. 
A path tool is used to create a path. The path tool 
creates paths and shapes which can be duplicated and 
manipulated to create complex selections, masks and 
objects. The icon for path tool is shown in Figure 3.18.

Shape tool (Keyboard: U)
The shape tool lets the user create vector rectangles, 
rounded rectangles, circles, polygons, lines and custom 
shapes. This tool is useful when designing or creating 
shape masks for photos. The icon for shape tool is 
shown in Figure 3.19.

Fig. 3.17 Icon for type tool
T

Fig. 3.15: Icons for dodge, 
burn and sponge tools

Fig. 3.16 : Icon for pen tool

Fig. 3.18: Icon for path tool

Fig. 3.19: Icon for shape tool
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3D tools
3D tools are used to rotate, roll, drag, slide and scale 
3D objects. Photoshop allows creating and editing of 3D 
images using 3D tools. The icons for rotate, roll, drag, 
slide and scale tools are shown in Figure 3.20.

Hand tool (Keyboard: H)
The hand tool allows the user to click and drag around 
the Photoshop canvas. If the entire canvas fits on the 
screen, this tool would not do anything. It is for navigating 
around when the user zooms in, or when a picture is 
too big to fit on the screen such that only a part of the 
picture can be seen. This tool helps drag the portions of 
the picture that need to be seen on the visibility area. 
The icon for hand tool is shown in Figure 3.21.

Zoom tool (Keyboard: Z)
Zoom tool lets the user zoom in and out of the Photoshop 
canvas by clicking on a given area. By default, the zoom 
tool lets one zoom in. To zoom out, hold down the option 
key and use the zoom tool as one normally would do. 
The icon for hand tool is shown in Figure 3.22.

Colour selection tools
These tools let one manage the colours being used. The 
colour on the top is the foreground colour, and the one 
at the back is the background colour. The foreground 
colour is what the brushes will use. The two smaller 
icons on the top are shortcut functions. The left one, 
showing a black square on a white square will set the 
foreground and background colours to the default 
(Keyboard: D). The double-headed curved arrow will swap 
the foreground and background colours (Keyboard: X). 
Clicking on either the foreground or background colour 
will bring up a colour picker, so that the user can set 
them precisely to what one wants. The icon for colour 
selection tool is shown in Figure 3.23.

Palettes
Palettes are group of tools used to edit and manipulate 
an image. These can be seen on the right side of the Fig. 3.23: Icon for colour 

selection tool

Fig. 3.20: Icons for 3D tools

Fig. 3.21 Icon for hand tool

Fig. 3.22 Icon for zoom tool
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screen, when one opens Adobe Photoshop. Palettes 
include tools palette, options palette, layers palette, 
adjustment palette, colour palette, and history palette. 
These can be shown or hidden by using the Window 
menu and selecting the palette one  wish to reveal. They 
make it easy to navigate through the document, make 
or add layer adjustments and switch modes. The icon 
for palettes is shown in Figure 3.24.

Layers Palette
The layers palette is the 
control panel for layers in 
Photoshop. Layers are like 
stacks of transparent papers 
placed one above the other. 
Layers can be placed one on 
top of another, and moved 
around by clicking on the 
layer name and dragging 
the mouse up or down. You 
can use the layer palette to 
hide, view, rearrange, delete, 

rename, and merge layers. The icon for layers palette is 
shown in Figure 3.25.

Adjustments Panel
Adjustments panel is where one can easily create and 
edit adjustment layers. Adjustment layers are non-
destructive image alterations that affect all layers below 
them, and can easily be turned on and off. Their most 
common use is for colour correction (level and curve 
adjustments), but there are many kinds of adjustments 
one can perform that can dramatically alter the look of 
an image. The icon for adjustments panel is shown in 
Figure 3.26.

Colour channels
The colour channels palette allows one to look at  
specific colours that make a picture. If one is 
in RGB mode, one will get red, green and blue  
colours. These colour channels will differ if one is in a 

Fig. 3.24: Icon for palettes

Fig. 3.25: Icon for 
Layers Palette

Fig. 3.26: Icon for 
Adjustments Panel
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different colour space (such as CMYK). 
When one chooses a specific colour, 
an image will be shown in different 
versions of black and white. This is 
because each colour channel is simply 
monochromatic, representing light in 
each channel. Switching between these 
channels is useful for making colour 
channel-specific touch-ups, overall 
contrast enhancements, and also for 
converting a photo into black and white. 
The icon for colour channels is shown in 
Figure 3.27.

Colour picker 
This palette lets one easily alter the  
foreground and background colours 
using sliders. The icon for colour picker 
is shown in Figure 3.28.

Colour swatches palette
Colour swatches show a large variety of 
colours, tints, gradients, and patterns.  
The colour swatches palette is a set 
of pre-defined colours one can choose 
from. One can compare colours and 
try different combinations. The icon  
for colour swatches palette is shown in 
Figure 3.29.

History palette
The history palette allows one to go back 
in time to undo previous alterations. The 
standard undo command (in the edit 
menu) will toggle between undoing and 
redoing the latest action performed on 
an image. The history panel is where one 
can go back much further (50 actions by 
default). The icon for history palette is 
shown in Figure 3.30.

Fig. 3.29: Icon for Colour Swatches Palette

Fig. 3.28: Icon for Colour Picker

Fig. 3.30: Icon for History Palette
		  A— sets the source for the history brush
		  B— Thumbnail of a snapshot
		  C— History state
		  D— History state slider

Fig. 3.27: Icon for Colour Channels
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Text and paragraph palette
The text and paragraph palette allows the user to 
make all sorts of adjustments to a text created with 
the Type tool. These options are similar to what one 
finds in word processing but one can also specify 
things like character width and spacing, which 
are more useful in design. The icon for text and 
paragraph palette is shown in Figure 3.31.

Menu bar
The menu bar is used to open and save files, 
adjust the canvas size, access some of the editing 
tools, open and close various windows, and more. 
The menu bar consists of ten menus, namely—
File, Edit, Image, Layer, Type, Select, Filter, View, 
Window, and Help. Each of those main menus has 
additional sub-menus. The icon for menu bar is 
shown in Figure 3.32.

Let us now look at each of these menus. 

File
Just like any word processing software, file menu 
in Photoshop is used for making new files, opening 
existing ones, saving files, and printing. To see the File 
menu, press the Alt and F keys simultaneously. Using 
the Open Recent option under the File menu, you can 
access the 10 most recently opened files.

Edit
Using the Edit menu, you can cut, copy,  paste, and 
also do, undo or redo a recent action. It is mainly used 
to transform layers and set colour spaces.

Image
Using the Image menu, you can change the mode of 
the whole canvas, between modes like RGB colour, 
grayscale, CMYK colour, multichannel and duotone. 
A sub-menu of Image menus, called as Adjustments, 
lets you access various tools for changing the image’s 
brightness, contrast, levels, exposure, vibrancies, hue, 

Fig. 3.32: Icon for Menu Bar

Fig. 3.31: Icon for Text and 
Paragraph Palette
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saturation and colour balance. In Image menu, you 
will also find Photo Filter, Channel Mixer, and Colour 
Lookup tools. There are other options, such as Auto 
Tone, Auto Contrast, Auto Colour, Image size, Canvas 
size, Crop and Trim available with image menu.

Layer
Using this menu, you can create new layers, duplicate 
the existing ones, delete and rename layers. One has 
options for creating layer masks, adjustment layers, 
and fill layers. One can also use it to create and edit 
smart objects, or export their contents to a file or 
replace the contents with that of another smart object. 
You can group and hide layers, lock layers, arrange 
layers behind or in front of other ones, link and merge 
layers, and flatten the image to automatically merge all 
the layers.

Type 
Type menu helps you to manipulate the text on the 
canvas. The first option lets you show or hide the 
character, character styles, paragraph, and paragraph 
style panels. Using the type menu, one can create work 
paths, convert a text layer to a shape, rasterise the text 
layer to make it an image, warp the text, change the 
font preview size, and change language options.

Select
Using the Select menu, one can select all the layers and 
deselect everything from this menu. The Refine Edge tool 
in this menu is used to change the edge of a selection. 
The Grow option in this menu can automatically  
increase the selection to nearby pixels to effectively 
increase the overall selection area. 

Filter
Photoshop Filters can blur, sharpen, distort and alter 
an image. You can use filter menu to preview artistic, 
brush stroke, distort, sketch, texture and other built-in 
filters.

Rasterisation refers 
to the task of taking 
an image described in 
vector graphics format, 
and converting into a 
raster image.
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View
The View menu includes tools that enable a ruler and 
create guides that one can follow for precise positioning, 
and change over to full screen mode. It provides for 
different ways of looking at the images. One can zoom in 
or zoom out to show the actual pixel size, and also zoom 
as per the print size.

Window
Window menu is used to selectively show or  
hide windows and arrange workspace. It can be used 
to toggle windows of Actions, Adjustments, Brush, 
Channels, Colour, History, Layers, Notes, Paths, 
Timeline and Tools.

Help
The Help menu allows to search information about the 
specific functions and solutions in Photoshop. 

Brush and Tool Presets in Photoshop
One can save a set of brush options as a preset in order 
to quickly access brush characteristics that one would 
like to use frequently. Photoshop includes several 
sample brush presets (Figure 3.33). One can start with 
these presets and modify them to produce new effects. 
Many original brush presets are available for download 
on the web.

One can quickly choose presets from the ‘brush 
preset’ picker in the options bar, which allows one to 
temporarily modify the size of a brush preset.

One needs to save tool presets when one wants to 
store customised brush tip characteristics along with 
settings from the options bar, such as opacity, flow and 
colour. 

Brush tip options
The brush tip options control how the colour is applied. 
One can apply colour gradually with soft edges, large 
brush strokes, various brush dynamics, different 
blending properties and different shapes. One can apply 
a texture or simulate spraying paint with an airbrush. 
One can use the Brush panel to set brush tip options. 

Notes
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Paint Tool options

Modes
Modes set the method for blending the colour one paints 
with the underlying existing pixels. The available modes 
change with the currently selected tool. Paint modes are 
similar to layer blending modes. 

Fig. 3.33: A view of brush tip tool options in brush presets in Adobe Photoshop

Opacity
Opacity determines how we ‘see-through’ the contents 
of the layer. 100 per cent opacity means that the layer 
is completely opaque, and anything painted on the layer 
will completely hide whatever is beneath it. Reducing 
the opacity allows the layer(s) under it to show through 
(Figure 3.34). As one paints over an area, the opacity 
does not exceed the set level no matter how many times 
one moves the pointer over the area, until one releases 
the mouse button. If one strokes over the area again, one 
applies additional colour, equivalent to the set opacity. 

Fig. 3.34: A view of brush tool with opacity option in Adobe Photoshop

Notes
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Flow
Flow sets the rate at which colour is applied as one 
moves the pointer over an area (Figure 3.35). As one 
paints an area, while holding down the mouse button, 
the amount of colour builds up based on the flow rate. 
For example, if one sets the opacity to 33 and the flow 
also to 33 per cent, each time one moves over an area, 
its colour moves 33 per cent towards the brush colour. 
The total will not exceed 33 per cent opacity unless  
one releases the mouse button and strokes over the 
area again.

Fig. 3.35: A view of brush tool with flow option in Adobe Photoshop

Graphic Design Basics in Photoshop
There are three kinds of graphics that we generally work 
on in Adobe Photoshop software. These are as follows: 
	 (i)	 Vector graphics
	 (ii)	 Raster graphics
	 (iii)	 Scalable vector graphics

Vector graphics
Vector graphics is the creation of digital images through 
a sequence of commands that place lines and shapes in 
a given two-dimensional or three-dimensional space. If 
you enlarge a vector graphic, the mathematical formula 
stays the same, rendering the same visual graphic 
irrespective of the size. Thus, vector graphics can be 
scaled to any size without losing quality. A vector file is 
also called as geometric file, and it is easier to modify 
than raster image file. Vector programmes are best for 
creating logos, drawings, illustrations and technical 
drawings.

Notes
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Raster graphics
Raster graphics or bitmap image is a dot matrix data 
structure, representing, generally, a rectangular grid 
of pixels, or points of colour. Raster images, which are 
made of pixels, are created with pixel-based programmes 
or captured with a camera or scanner. A raster image 
has a specific number of pixels; therefore, if you enlarge 
the image file without changing the number of pixels, 
the image will look blur. Raster programmes are best 
for editing photos and creating continuous tone images 
with soft colour blends.

A vector image can be converted into a raster graphic 
image, which maps bits directly to a display space. The 
vector image can be converted to a raster image file prior 
to its display so that it can be ported between systems. 

Scalable vector graphics
Scalable Vector Graphics is an XML (Extensible 
Markup Language) based vector image format for two-
dimensional graphics, with support for interactivity and 
animation. SVG images can be created and edited with 
any text editor, as well as, drawing software.

Selecting Cursor Preference
The painting tools have three possible cursors: standard 
cursor (icon from the toolbox), cross hair (denoted with 
symbol ‘ ’), and a cursor that matches the size and 
shape of the currently selected brush tip.
	 (1)	 Choose Edit> Preferences> Cursors (Windows) or 

Photoshop> Preferences> Cursors (Mac OS).
	 (2)	 Select the desired cursors in both the Painting 

Cursor area and the Other Cursor area. The 
sample cursors change to reflect your choices. 
For a Brush Tip cursor, choose a size and include 
a cross hair in the cursor.
yy Normal Brush Tip restricts the cursor size to 

areas of the brush stroke that have 50 per cent 
or more opacity.

yy Full Size Brush Tip sizes the cursor to the 
entire area affected by the brush stroke. For 

Notes
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soft brushes, this produces a larger cursor size 
than the normal setting to include areas of the 
brush stroke with lighter opacity.

Practical Exercises
Activity 1

Using brush tool in Adobe Photoshop

Material required

computer, Adobe Photoshop software

Procedure

yy Create digital graphics on a blank canvas of 800 × 600 
pixels with a resolution of 150 pixels per inch. The 
background must be white. Click on the brush tool and 
create five different strokes with brush hardness of 32 per 
cent and with the given size of brushes — 10, 20, 30, 40  
and 50.

yy Now, observe and compare these five different strokes 
on the digital canvas. 

yy Click on the Brush Tool and create five different strokes of 
red colour with brush hardness of 32 per cent, and with 
five different size of brushes — 5, 25, 45, 65 and 85.

Choose a foreground colour. 
yy Select the Brush or Pencil tool. The Brush tool creates 

soft, as well as, hard strokes of a colour. The Pencil tool 
creates only hard-edged lines.

yy Choose a brush from the Brush Presets panel. 
yy Set tool options for mode and opacity in the options bar.

Do one or more of the following:
yy Click and drag in the image to paint.
yy To draw a straight line, click at a starting point in the 

image. Press the Shift key and click at an ending point.
yy When using the Brush tool as an airbrush, press the 

mouse button without dragging to build up colour.
yy Now, observe and compare these five different strokes 

on the digital canvas.

Check Your Progress
A.	 Fill in the Blanks

1.	 Vector graphics is the creation of digital images through 
a sequence of commands that place _______________ and 
shapes in a given two-dimensional or three-dimensional 
space.

Notes
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2.	 A _____________ graphics or bitmap image is a dot matrix 
data structure, representing a generally rectangular 
grid of pixels, or points of colour, viewable via a monitor, 
paper or other display medium.

3.	 Scalable ______________ graphics is an XML-based 
vector image format for two-dimensional graphics with 
support for interactivity and animation.

4.	 The Brush and ______________ tool work like traditional 
drawing tools applying colour with brush strokes.

5.	 The _____________ tool helps in moving objects in a given 
layer around the Adobe Photoshop canvas.

6.	 The _______________ tool helps in selecting a part of the 
canvas in a specific shape.

7.	 The ______________ is a free-form selection tool that lets 
you drag around the canvas.

8.	 The colour ________________ palette is a set of pre-
defined colours. 

B.	 Subjective question

1.	 Describe the functions of any five drawing and painting 
tools of Adobe Photoshop.

What Have You Learnt?
On completion of this session, you will be able to:

yy differentiate between various kinds of graphics.
yy demonstrate the use of tools for painting and editing 

image colour.
yy create a digital graphic using appropriate tools for 

editing and painting image.

Session 3: Blending Modes

Blending Mode
Blending mode, as specified in the options bar, controls 
how pixels in the image are affected by a painting or 
editing tool. The majority of blend modes have keyboard 
shortcuts. 

yy The base colour is the original colour in the image.
yy The blend colour is the colour being applied with 

the painting or editing tool.
yy The result colour is the new colour formed from 

the blend.

Notes
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Normal
Dissolve Normal

Darken
Multiply
Colour Burn
Linear Burn

Darken

Lighten
Screen
Colour Dodge
Linear Dodge (Add)

Lighten

Overlay
Soft Light
Hard Light
Vivid Light
Linear Light
Pin Light
Hard Mix

Contrast

Difference
Exclusion
Subtract
Divide

Inversion

Cancellation

Hue
Saturations
Colour
Luminosity

Component

Fig. 3.36: Blend mode groups

Fig. 3.37: Keyboard shortcuts to blend 
modes in Adobe Photoshop (Windows)

Shift + Alt + 
Option+

Normal N

Dissolve I
Darken K
Multiply M
Colour Burn B
Linear Burn A
Lighten G
Screen S
Colour Dodge D
Linear Dodge 
(Add)

W

Overlay O
Soft Light F
Hard Light H
Vivid Light V
Linear Light J
Pin Light Z
Hard Mix L
Difference E
Exclusion X
Hue U
Saturation T
Colour C
Luminosity Y

Normal
It is a blending mode that edits or paints each pixel to 
make it the resultant colour. In the case of a painting 
tool, the blend colour will completely coat the base 
colour, whereas in the case of an edit tool, the edit value 
will completely override the existing colour.

In the case of a painting tool, the blend colour will 
completely coat the base colour. In case of an edit tool, 
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the edit value will completely override 
the existing colour. This is the default 
mode. Normal mode is called ‘threshold’ 
when one is working with a bitmapped 
or indexed-colour image (Figure 3.38).

Dissolve
‘Dissolve’ is used to edit or paint each 
pixel to bring out the resultant colour. 
However, the resultant colour is a 
random replacement of the pixels with 
the base or blend colour, depending 
on the opacity at any pixel location  
(Fig 3.39). This mode can be seen only 
on a layer with an opacity setting of less 
than 100 per cent.

Fig. 3.38: Use of normal mode 

Fig. 3.39: Use of dissolve blending mode 
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Behind
‘Behind’ mode edits or paints only on the transparent 
part of a layer. This mode works only in layers with Lock 
Transparency deselected and is analogous to painting 
on the back of transparent areas on a sheet of acetate.

Darken
Pixels lighter than the blend colour are replaced, and 
those darker than the blend colour do not change.

Multiply
It is a blending mode that looks at the colour information 
in each channel and multiplies the base colour by the 
blend colour. The resultant colour is always a darker 
colour. Multiplying any colour with black produces 
black. Multiplying any colour with white leaves the 
colour unchanged. When you are painting with a colour 
other than black or white, successive strokes with a 
painting tool produce progressively darker colours. The 
effect is similar to drawing on the image with multiple 
marking pens (Figure 3.40).

Fig. 3.40: Use of multiply blending mode 
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Colour burn
It is a blending mode that looks at the colour information 
in each channel and darkens the base colour to reflect 
the blend colour by increasing the contrast between the 
two. Blending with white produces no change.

Linear burn
Linear burn mode looks at the colour information in 
each channel and darkens the base colour to reflect the 
blend colour by decreasing the brightness. Blending 
with white produces no change.

Lighten
It looks at the colour information in each channel and 
selects the base or blend colour—whichever is lighter—
as the resultant colour. Pixels darker than the blend 
colour are replaced, and pixels lighter than the blend 
colour do not change.

Screen
The Screen looks at each channel’s colour information 
and multiplies the inverse of the blend and base colours. 
The resultant colour is always a lighter colour. Screening 
with black would not change the colour. Screening with 
white produces white. The effect is similar to projecting 
multiple photographic slides on top of each other.

Colour dodge
The ‘colour dodge’ mode looks at the colour information 
in each channel and brightens the base colour to reflect 
the blend colour by decreasing contrast between the 
two. Blending with black produces no change.

Linear dodge
It looks at the colour information in each channel and 
brightens the base colour to reflect the blend colour by 
increasing the brightness. Blending with black produces 
no change.

Overlay
Overlay multiplies or screens the colours, depending on 
the base colour. Patterns or colours overlay the existing 

Notes
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pixels while preserving the highlights and shadows of 
the base colour. The base colour is not replaced but 
mixed with the blend colour to reflect the lightness or 
darkness of the original colour (Figure 3.41).

Fig. 3.41: Use of overlay blending mode

Soft light
This blending mode darkens or lightens the colours, 
depending on the blend colour. The effect is similar to 
shining a diffused spotlight on the image. If the blend 
colour (light source) is lighter than 50% grey, the image 
is lightened as if it were dodged. If the blend colour is 
darker than 50 per cent grey, the image is darkened. 

Hard light
Hard light blending modes multiply or screen the 
colours, depending on the blend colour. The effect is 
similar to shining a harsh spotlight on the image. If 
the blend colour (light source) is lighter than 50 per 
cent grey, the image is lightened, as if it were screened. 
This is useful for adding highlights to an image. If the 
blend colour is darker than 50 per cent grey, the image 
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is darkened, as if it were multiplied. This is useful for 
adding shadows to an image (Figure 3.42). 

Vivid light
The ‘vivid light’ mode burns or dodges the colours by 
increasing or decreasing the contrast, depending on 
the blend colour. If the blend colour (light source) is 
lighter than 50 per cent grey, the image is lightened 
by decreasing the contrast. If the blend colour is 
darker than 50 per cent grey, the image is darkened by 
increasing the contrast.

Linear light
The linear light mode burns or dodges the colours by 
decreasing or increasing the brightness, depending on 
the blend colour. If the blend colour (light source) is 
lighter than 50 per cent grey, the image is lightened 
by increasing the brightness. If the blend colour is 
darker than 50 per cent grey, the image is darkened by 
decreasing the brightness.

Pin light
It replaces the colours, depending on the blend colour. 
If the blend colour (light source) is lighter than 50 
per cent grey, pixels darker than the blend colour are 

Fig. 3.42: Use of hard light blending mode

Notes
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replaced, and pixels lighter than the blend colour do not 
change. If the blend colour is darker than 50 per cent 
grey, pixels lighter than the blend colour are replaced, 
and pixels darker than the blend colour do not change. 
This is useful for adding special effects to an image 
(Figure 3.43).

Fig. 3.43: Use of pin light blending mode

Hard mix
The ‘hard mix’ mode adds red, green and blue channel 
values of the blend colour to the RGB values of the 
base colour. If the resulting sum for a channel is 255 or 
greater, it receives a value of 255; if less than 255, then 
the value of 0 is recieved. Therefore, all blended pixels 
have red, green and blue channel values of either 0 or 
255. This changes all pixels to primary additive colours 
(red, green or blue), white or black.

Practical Exercises
Activity 1

Understanding blending mode

Material required

computer, Adobe Photoshop software

Procedure

yy Create a digital graphic on a blank canvas of size 800 × 
600 pixels, Resolution: 150 pixels per inch with white 
background. 

Notes
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yy Import two different photographs and resize them to 
overlap with each other in two different layers.

yy Now, select the topmost 
layer and change the 
blending mode of this 
layer to Colour Burn.

yy Now, observe the 
difference in the blending 
of these two different 
images in the same file. 
We have changed the 
blending mode of the 
topmost layer.

yy Now, you can export this file to JPG format to be used 
in either MS PowerPoint as background graphics or 
taking out a digital printout.

Activity 2

Understanding the difference between blending mode and 
overlay mode

Material required

Computer, Adobe Photoshop software

Procedure

yy Create a digital graphics on a blank canvas of size 800 
× 600 pixels, Resolution: 150 pixels per inch with white 
background. 

yy Import two different photographs and resize them to 
overlap with each other in two different layers.

yy Now, select the topmost layer and change the Blending 
Mode of this layer to Overlay Mode.

yy Now, observe the difference in the blending of these two 
images in the same file. We have changed the Blending 
Mode of the topmost layer. 

yy Now, export this file to JPG format to be used in either 
MS PowerPoint as background graphics or take out a 
digital printout.

Notes
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Check Your Progress

A.	 Match the Columns

Column A Column B
1. It darkens or lightens the colour 

depending on the blend colour. The 
effect is similar to shining a diffused 
spotlight on an image.

(a) Vivid light

2. Multiplies or screens the colours, 
depending on the blend colour. The 
effect is similar to shining a harsh 
spotlight on the image.

(b) Hard light

3. Burns or dodges the colours 
by increasing or decreasing the 
contrast, depending on the blend 
colour.

(c) Soft light

4. Burns or dodges the colours 
by decreasing or increasing the 
brightness, depending on the blend 
colour.

(d) Linear light

B.	 Subjective Questions

1.	 Explain the following modes of blending.
(a)	 Dissolve
(b)	 Darken
(c)	 Colour burn
(d)	 Linear burn
(e)	 Screen 

2.	 Describe the use and application of blending modes.

What Have You Learnt?
On completion of this session, you will be able to:

yy demonstrate the knowledge of different blending modes.

Session 4: Colour Modes

The colour mode or image mode determines how colours 
combine, based on the number of channels. Different 
colour modes result in different levels of colour detail and 
file size. Use CMYK colour mode for images in a full colour 
print brochure, and RGB colour mode for images in web 
or E-mail. The various colour modes are given hereby.

Notes
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	 1.	 Bitmap 
	 2.	 Grayscale
	 3.	 Duotone
	 4.	 Indexed colour
	 5.	 RGB 
	 6.	 CMYK colour 
	 7.	 Lab colour
	 8.	 Multichannel

Bitmap Mode
A Bitmap is an image where each pixel is either black 
or white (no shades in between). Bitmap images can 
be compressed making the file size very small, despite 
having a lot of pixels. It is useful for printing or archiving 
paper documents. The bitmap colour mode has a bit 
depth of 1, hence also called bitmapped 1-bit images.

You can convert a colour image into bitmap through 
the following steps:

yy First, convert your image into the grayscale colour 
mode. 

yy On top Menu, click on Image >> Mode >>Grayscale
yy Now click ‘OK’ in ‘Discard Colour Information?’ 

dialog box.
yy Your image will get converted to grayscale.
yy Now go to the top Menu again, click on Image >> 

Mode >> Bitmap
yy Your image will get converted to Bitmap.

Fig. 3.44: A view of mode menu under image tab in 
Adobe Photoshop

Notes
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Grayscale Mode
Grayscale mode uses different shades of grey in an 
image. In an 8 bits image, there can be up to 256 shades 
of grey. Every pixel of a grayscale image has a brightness 
value ranging from 0 (black) to 255 (white). In a 16 and 
32 bits image, the number of shades is much greater 
than that in an 8 bits image.

Grayscale values can also be measured as percentages 
of black ink coverage (0 per cent is equal to white, 100 
per cent is equal to black).

Grayscale mode uses the range defined by the 
workspace setting that one specifies in the Colour 
Settings dialog box. You can convert the image into 
grayscale through the following steps:

On top Menu, click on Image >> Mode >> Grayscale.

Duotone
Monotone means a single colour, duotone means two-
colour, tritone is three-colour and quadtone is four-
colour. An image can be converted to Duotone through 
the following steps: 

Image menu >> Mode >>Grayscale>> OK. Again, go 
to Image menu >> Mode >> Duotone. Select a Preset 
and Type. Click OK.

Indexed Colour
Indexed colour mode produces 8 bits image files with 
up to 256 colours. When converting to indexed colour, 
Photoshop builds a colour lookup table (CLUT), which 
stores and indexes the colours in the image. If a colour 
in the original image does not appear in the table, the 
programme chooses the closest one or uses dithering to 
simulate the colour using available colours. Although 
its palette of colours is limited, indexed colour can 
reduce the file size and yet maintain the visual quality 
needed for multimedia presentations, web pages, etc. 
For extensive editing, one needs to convert the existing 
image temporarily into RGB mode.

Indexed colour files can be saved in Photoshop, 
BMP, DICOM (Digital Imaging and Communications 
in Medicine), GIF, Photoshop EPS, Large Document 

Notes
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Format (PSB), PCX, Photoshop PDF, Photoshop Raw, 
Photoshop 2.0, PICT, PNG, Targa, or TIFF formats.

RGB
Photoshop RGB colour mode uses the RGB (Red, Green 
and Blue) model, assigning an intensity value to each 
pixel. In an 8 bits per channel image, the intensity value 
ranges from 0 (black) to 255 (white) for each of the RGB 
components. For example, a bright red colour has an 
R value of 246, G of 20 and B of 50. When the values 
of all three components are equal, the result is a shade 
of neutral grey. When the values of all components are 
255, the result is white. When the values are 0, the 
result is black.

RGB images use three colours or channels to 
reproduce colours on screen. In 8 bits per channel 
image, the three channels translate to 24 (8 bits × 3 
channels) bits of colour information per pixel. With 24 
bits images, the three channels can reproduce up to 
16.7 million colours per pixel.

Although RGB is the standard colour model, the exact 
range of colours represented can vary, depending on 
the application or display device. The RGB colour mode 
in Adobe Photoshop varies according to the workspace 
setting that is specified in the Colour Settings dialog 
box. You can convert an image to RGB colour through 
the following steps: 

Image menu >> Mode >> RGB Colour.

CMYK Colour Mode
In the CMYK mode, each pixel is assigned a percentage 
value for each of the process inks. The lightest (highlight) 
colours are assigned small percentages of process ink 
colours, while darker (shadow) colours have higher 
percentages. For example, a bright red might contain 2 
per cent cyan, 93 per cent magenta, 90 per cent yellow, 
and 0 per cent black. In CMYK images, white colour is 
generated when all the four components have values of 
0 per cent.

One needs to use the CMYK mode when preparing  
an image to be printed using process colours. Converting 
an RGB image into CMYK creates colour separation. 

Notes

Unit-3.indd   76 1/7/2021   2:11:42 PM



77

Drawing and Painting using Adobe Photoshop

If one starts with an RGB image, it is best to edit first 
in RGB, and then, convert it into CMYK at the end of 
the editing process. In RGB mode, one can use the 
‘Proof Setup’ command to simulate the effects of CMYK 
conversion without changing the actual image data. One 
can also use CMYK mode to work directly with CMYK 
images scanned or imported from high-end systems. 
Although CMYK is a standard colour model, the exact 
range of colours represented can vary, depending on the 
press and printing conditions. The CMYK colour mode in 
Photoshop varies according to the workspace setting that 
one specifies in the Colour Settings dialog box. You can 
convert an image to CMYK by the following steps: 

Click on Image menu>> click on Mode>> click CMYK. 
Then, click on the OK button to convert the image to 
CMYK colour mode.

Lab Colour
The Lab colour mode is a combination of three 
components i.e., ‘L’ for lightness and ‘a’ and ‘b’ are the 
axis components. The lightness ranges from 0 to 100, 
whereas the ‘a’ component (green-red axis), and the ‘b’ 
component (blue-yellow axis) ranges from +127 to –128.
You can convert an image to lab colour through the 
following steps:

Go to Image menu > click on it. Next, select Mode >> 
click on Lab Colour.

Multichannel 
The Multichannel colour mode gives 256 shades of 
grey in each channel. It is used for specialised printing. 
You can convert an image to multichannel through the 
following steps:

Image menu >> Mode >> Multichannel.

Practical Exercises
Activity 1

Understanding grayscale mode

Material required

Computer, Adobe Photoshop software

Notes

Unit-3.indd   77 1/7/2021   2:11:42 PM



78

Texturing Artist — Class XI

Procedure

yy Create a digital graphic 
on a blank canvas of 
size 800  × 600 pixels, 
Resolution: 150 pixels/
inch, white background 
and RGB default colour 
mode.

yy Import two different 
photographs and 
resize them to overlap. 
Use different tools to 
develop a creative 
design. Now, go to Main Menu > Image > Mode and 
select Grayscale colour mode. 

yy Now you can export this file to JPG or take out a digital 
printout,  at it is now using 8 Bit Grayscale colour mode 
and the file size will be small.

Activity 2

Understanding Bitmap colour mode

Material required

Adobe Photoshop software

Procedure 

yy Use the same graphics file, which is now in grayscale 
colour mode. You will see that the previously disabled 
Bitmap colour mode is now enabled. 

yy Go to main menu > Image > Mode and select Bitmap 
colour mode. 

Notes
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yy Select 72 pixels per inch.
yy Now, export this file to 

JPG format to be used in 
either MS PowerPoint as 
background graphics or 
take out a digital printout. 
This is now using 1 Bit 
image with only two 
colours, i.e., either black 
or white dots as seen in 
the output of the graphics file.

Check Your Progress
A.	 Multiple Choice Questions

1.	 RGB mode can display _______________.
(a)	 millions of colours 
(b)	 256 colours 
(c)	 256 grey shades 
(d)	 four printed colours

2.	 CMYK has ___________________. 
(a)	 millions of colours 
(b)	 256 colours 
(c)	 256 grey shades 
(d)	 four printed colours

3.	 Indexed mode has up to _________________.
(a)	 millions of colours 
(b)	 256 colours 
(c)	 256 grey shades 
(d)	 four printed colours

Notes
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4.	 Grayscale mode can have up to  _______________. 
(a)	 millions of colours 
(b)	 256 colours 
(c)	 256 grey shades 
(d)	 four printed colours

B.	 Subjective Questions

1.	 Differentiate between grayscale mode and indexed 
colour mode.

2.	 Write short notes on the following:
(a)	 RGB colour mode
(b)	 CMYK colour mode
(c)	 Grayscale mode 
(d)	 Bitmap mode
(e)	 Indexed colour mode

What Have You Learnt?
On completion of this session, you will be able to:

yy select the image using RGB, CMYK, Index, grayscale 
and Bitmap mode.

Session 5: Image 
Adjustment and 
Colour Correction

An adjustment layer can 
be used to increase the 
brightness or contrast of a 
photograph without altering 
the original photo. When an 
adjustment layer is added 
to an image, a new layer will 
appear over the image and 
Properties panel specific 
to the type of adjustment 
selected will pop up. The 
Properties panel allows 
to modify the adjustment 
layer, which in turn will Fig. 3.45: Adjustment menu in Image tab

modify the image. To use an adjustment layer, click on 
its icon in the Adjustment Layers panel. 
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Expanding an individual property reveals a 
graphical  control such as a slider or dial. You can then 
dial in the effect you want in the Properties panel. The 
controls for each adjustment layer are different and 
specific to its purpose. The major colour correction 
tools are as follows:
	 1.	 Brightness 
	 2.	 Contrast
	 3.	 Levels
	 4.	 Curves
	 5.	 Exposure
	 6.	 Vibrance
	 7.	 Hue or Saturation 
	 8.	 Colour balance 

Brightness and Contrast
The brightness and contrast adjustment lets the 
user make simple adjustments to the tonal range of 
an image. Moving the brightness slider to the right 
increases tonal values and expands image highlights. 
Moving the slider to the left decreases tonal values 
and expands shadows. The contrast slider expands 
or shrinks the overall range of tonal values in the 
image (Figure 3.46).

Let us now try to adjust the brightness and contrast.
yy In the menu bar, select Image > Adjustments > 

Brightness/Contrast.
yy Adjust the Brightness slider to change the overall 

brightness of the image. Adjust the Contrast 
slider to increase or decrease image contrast.

yy Click OK. 
The adjustments will appear only on the selected layer.
In normal mode, brightness or contrast applies 

proportionate adjustments to the image layer. When 
‘Use Legacy’ option is selected, Brightness/Contrast 
simply shifts all pixel values to a higher or lower level. 
Since this can cause clipping or loss of image detail in 
highlight or shadow areas, using Brightness/Contrast 
in Legacy mode is not recommended for photographic 
images. However, it can be useful for editing masks or 
scientific imagery.

Fig. 3.46: Brightness or contrast 
adjustment
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Input and Output Levels
When we use the levels adjustment layer, we 
can see two main sliders in the settings: the 
first, with a histogram, is called ‘input levels’. 
The input level black and white determines what 
value of input is pure black and what value is 
pure white. The black slider specifies which 
input values should be black. Anything to the 
left of the slider is going to be black. Similarly 
with the white slider, one has to specify the 
threshold of input data that should be treated 
as white. The middle slider is your midpoint. 

Input levels are adjustments to the levels that are 
coming into the system. Whereas, output levels are 
adjustments to levels going out of the system. The 
output level black and white determines what colour 
should be used for the black point and white point 
of the final image. By default, the Output sliders are 

at level 0, where the pixels are 
black, and at level 255, where the 
pixels are white (Fig. 3.47).

With the Output sliders in the 
default positions, moving the black 
input slider maps the pixel value 
to level 0 and moving the white 
point slider maps the pixel value to 
level 255. The remaining levels are 
redistributed between Levels 0 and 
255. This redistribution increases 
the tonal range of the image, 
in effect increasing the overall 
contrast of the image. The level 
adjustments are used to correct 

the tonal range and colour balance of an image by 
adjusting intensity levels of image shadows, midtones, 
and highlights. The Levels histogram is a visual guide 
for adjusting the image key tones (Figure 3.48).
	 A. Shadows 
	 B. Midtones 
	 C. Highlights 
	 D. Output level sliders

Fig. 3.47: Level adjustments

Fig. 3.48: Tonal adjustments
A— shadows,
B— midtones,
C— highlights,
D— Output level sliders
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Hue or Saturation
You have learnt earlier that hue is the 
colour in the image, saturation is the 
intensity, or richness of that colour, and 
the lightness controls the brightness 
value. The Hue or Saturation Command 
in Photoshop enables you to adjust the 
colours in your image based on their 
hue, saturation, and lightness. The Hue 
or Saturation icon can be found in the 
Adjustments panel. This adjustment is 
especially good for fine-tuning colours in 
a CMYK image (Fig. 3.49).

yy Let us now try to adjust the hue 
or saturation. Choose Layer > New Adjustment 
Layer > Hue or Saturation. Click OK in the New 
Layer dialog box. 

yy In the Properties panel, choose from the menu to 
the right of On-image adjustment tool.

yy Choose Master to adjust all colours at once.
yy Choose one of the other preset colour ranges 

listed for the colour you 
want to adjust. To modify the 
colour range, see the range of 
colours adjusted using Hue or 
Saturation.

yy Choose Hue or Saturation 
preset from the Preset menu.

To change the Hue, enter a 
value or drag the slider until you 
are satisfied with the colours. The 
values displayed in the box reflect 
the number of degrees of rotation 
around the wheel from the original 
colour of the pixel. A positive value 
indicates clockwise rotation; a 
negative value indicates counter-
clockwise rotation. Values can range 
from –180 to +180 (Figure 3.50).

Fig. 3.49: Hue or saturation adjustment window

90

0/360

A

B

180

270

Fig. 3.50: Hue and Saturation points in colour wheel, 
where A is Saturation and B is Hue
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Curves adjustment
In the Curves adjustment, you 
adjust points throughout an 
image’s tonal range. You can see 
the curves adjustment dialog 
box when you choose Layer > 
New Adjustment Layer > Curves 
(Figure 3.51). 

The standard curve is actually 
a straight line running diagonally 
across the grid from the bottom left 
to the top right of the chart. This 
straight line, by default, means ‘no               
adjustment at all’. The horizontal 
axis of the graph represents the 
input levels (original image values), 
and the vertical axis represents the 
output levels (new adjusted values). 

When adjusting an RGB 
image, the upper-right area of the 
graph represents the highlights 
and the lower-left area represents 
the shadows. One can adjust the 
Curve line in a couple of ways. 
One option is to click and drag on 

the line in an upward or downward direction to adjust 
the pixels of that tone in the photo. Another adjustment 
that you can perform using this technique is to drag the 
line into what is referred to as a shallow S-curve.

As you add control points to the line and move them, 
the shape of the curve changes, reflecting your image 
adjustments. The steeper sections of the curve represent 
areas of higher contrast while flatter sections represent 
areas of lower contrast. The Curves adjustment can also 
be applied to CMYK, Lab colour, or Grayscale images. 

Adjust image colour and tone with Curves
—	 Open the ‘Colour and Tone’ dialog box and apply 

the ‘Curves’ command. 
—	 A dialog box will appear allowing you to adjust 

the image tone by editing the graph.

Fig. 3.51: Curves options in properties panel — 
A. On-image adjustment tool; B. Sample in image 
to set black point; C. Sample in image to set gray 

point; D. Sample in image to set white point; E. Edit 
points to modify the curve; F. Draw to modify the 

curve; G. Curves preset menu; H. Set black point; I. Set 
gray point; J. Set white point; K. Show clipping. 
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—	 Moving a point in the — (a) top portion of the curve 
adjusts the highlights, (b) centre of the curve 
adjusts the midtones, and (c) bottom section of 
the curve adjusts the shadows. 

—	 To darken highlights, move a point near the top of 
the curve downward. 

—	 Moving a point either down or to the right maps the 
Input value to a lower Output value, and the image 
darkens. 

—	 To lighten the shadows, move a point near the 
bottom of the curve upward. 

—	 Moving a point either up or to the left maps a 
lower Input value to a higher Output value, and 
the image  becomes light (Figure 3.52).

—	 Click ‘OK’ to apply the correction.

Colour balance
The ‘colour balance’ command changes the overall 
mixture of colours in an image for generalised colour 
correction (Figure 3.53). The logic of this tool is based 
on RGB colour model.

For colour balancing, click on the Colour Balance 
icon in the Adjustments panel.

Choose Layer > New Adjustment Layer > Colour 
Balance. 

Fig. 3.52: Curves adjustments Fig. 3.53: A view of colour balance window
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Practical Exercises
Activity 1

Creating a digital graphics with Colour Balance Adjustment. 

Material required

computer, Adobe Photoshop software

Procedure

Step 1: 	Open a blank canvas of size 800 × 600 pixels, 
Resolution: 150 pixels per inch, and white background.

Step 2: 	 Import a colour photo (of a scene or portrait photo).
Step 3: 	 Go to Image > Adjustments > Colour Balance 
Step 4: 	Make sure that the composite channel is selected in 

the channels panel. This command is available only 
when you are viewing the composite channel.

Step 5: 	Do one of the following:
yy Click on the Colour Balance icon in the 

Adjustments panel.
yy Choose Layer > New Adjustment Layer > Colour 

Balance. 
yy One can also choose Image > Adjustments > 

Colour Balance. However, one must keep in mind 
that this method makes direct adjustments to the 
image layer and discards image information.

yy In the Properties panel, select Shadows, Midtones, 
or Highlights to select the tonal range in which the 
user wants to focus the changes. Select Preserve 
Luminosity to prevent changing the luminosity 
values in the image while changing the colour. This 
option maintains the tonal balance in the image. 
Drag a slider towards a colour that the user wants 
to increase in the image; drag the slider away from 
the colour that you want to decrease in the image. 
The values above the colour bars show the colour 
changes for red, green and blue channels (For Lab 
images, the values are for the A and B channels.) 
Values can range from –100 to +100.

Step 6:  Select OK and save the output to JPG file format and 
the original PSD File. View this developed JPG file in 
Windows photo viewer software.

Activity 2

Creating a digital graphics with partial grey colour and partial 
RGB colour. 

Material required

Adobe Photoshop Software

Notes
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Procedure

Step 1: 	 Open a blank canvas of size 800 × 600 pixels, 
Resolution: 150 pixels per inch and White Background.

Step 2:	 Import a colour photo (of a scene or portrait)
Step 3: 	 Select a portion of this image using the Selection tool.
Step 4:	 Go to Image > Adjustments > Select Hue or Saturation 
Step 5:	 Reduce the Saturation Control Slider to –100.
Step 6: 	 Deselect the de-saturated portion of the image and 

save the output to JPG file format and the Original 
PSD File. View this developed JPG file in Windows 
Photo Viewer Software.

Check Your Progress 
A.	 Fill in the Blanks

1.	 The _______________ command in Adobe Photoshop 
enables you to adjust the colours in your image, based 
on their hue.

2.	 The colour ______________ command changes the overall 
mixture of colours.

3.	 When adjusting an RGB image, the upper-right area of 
the graph represents the highlights and the lower-left 
area represents the ___________________.

B.	 Subjective Questions

1.	 Describe the functions of the following combination of 
keys:
(a)	 Ctrl + m
(b)	 Ctrl + u
(c)	 Ctrl + l
(d)	 Ctrl + b
(e)	 Ctrl + z

What Have You Learnt?
On completion of this session, you will be able to:

yy demonstrate the use of different correction tools for 
image preparation; 

yy adjust the brightness, contrast and saturation of the 
image.

Session 6: Digital Matte Painting

Digital painting is a method of doing an artwork on a 
system. It is a way of portraying our ideas and thoughts 
on the screen by adapting traditional painting mediums 

Notes
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like oil, ink, water colour, etc. Photoshop produces raster 
paintings. These paintings usually resembles a real 
painting made with real brushes and paint, thus they 
look more realistic than a vector painting or illustration. A 
digital painting maker tries to mimic the physical objects or 
people in their own virtual manner using virtual brushes 
and colours. Making use of photo textures can be a great 
way to enhance our artwork in Adobe Photoshop and 
make it look more realistic. Photo textures are actually a 
part of pictures and photographs and we can use them to 
add texture to our artwork using blending modes. Texture 
brushes can be used to add realistic details in our artwork. 
Also we can make our own brushes and can also find the 
brushes online.

Matte painting
Matte painting is a creative technique that filmmakers 
use to create backgrounds for scenes that cannot or do 
not exist in real life. It is an old technique in the visual 
effects industry. It is a painted representation of a large 
landscape that allows filmmakers to create the illusion of 
an environment that does not exist. It combines several 
techniques including 3D, photo manipulation, painting 
as well as retouching techniques in order to achieve 
quality result. Mattes are used to combine foreground 
image with the background image. The output depends 
on the skill level of the artists and technicians involved 
in matte painting. 

Steps for creating Digital Matte 
Painting
Before starting the matte painting 
scene, make a rough sketch of the 
world that you would like to create. 
You can refer to some images that 
could help you in your matte painting 
for colour correction and for the Depth 
of Field (DoF). You also need to decide 
the size of your painting. The range 
of the painting’s dimensions would 
depend on its intended use. 

Fig. 3.54: Step 1 for creating Digital Matte Painting
 (https://www.digitalartsonline.co.uk/

tutorials/photoshop/fantasy-digital-matte-
painting/?pn=2).
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Step 1
yy Open a new document by going to File > 

New and create a blank canvas of 5,700 × 
3,900 pixels.

yy Click and drag the photograph into the new 
document. Place the photo in the centre of 
the canvas, and then move it to the bottom 
right.

yy Search the photo of Machu Pichhu using 
Google Image search and download the 
same (Figure 3.54). 

Step 2
yy Use the Photoshop Eraser tool to remove 

the photograph’s sky area and then create 
a new layer named ‘Outlines’ above the 
photograph. We will now start extending 
the original plate.

yy Select a soft standard brush of about 30 
pixels and start drawing in the general 
outline of the new scenery that the user is 
going to add.

Step 3
yy Now that we have the general outlines of 

our new image, we can start painting in a 
bit more detail. 

yy Always begin with the element that is the 
furthest (usually, sky). 

yy Select the ‘Background’ layer and create a 
new layer named ‘Sky’. While still in brush 
mode, hold down Alt key to turn the cursor 
into a colour eyedropper and select the grey/
blue colour of the background mountains 
in the photograph. 

yy Now, use this colour to block in the sky 
(Figure 3.56).

Step 4
yy Add some storm clouds to the sky and 

establish the light source. Use a variety 
of different sized soft brushes and light 

Fig. 3.55: Step 2 for creating digital 
Matte Painting

Fig. 3.56: Step 3 for creating Digital 
Matte Painting

Fig. 3.57: Step 4 for creating 
Digital Matte Painting
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pen pressure to slowly build up the 
layers of stormy clouds. Also, add 
the sunbeam to give a more realistic 
look (Figure 3.57).

Step 5
yy Ensure the ‘Sky’ layer is still selected 

and create a new layer called ‘Right 
mountain’. 

yy Use the same technique that 
you used for creating the sky.  
This can be done by picking the 
colour of the right-hand mountain 
on the photograph and then blocking 
in that colour on your extension 
(Figure 3.58).

yy Add few more details to the mountain 
by picking various shades from the 
original photograph by applying it to 
your new layer. 

yy The sky and landscape extensions are 
all your imagination, but you can 
also use reference photographs.

Step 6
yy Select ‘Layer 1’ (the layer that is 

the original photograph), and now 
create a new layer named ‘Right 
Foreground Mountain’ (Figure 3.59).

yy Repeat Step 6, but add little more 
detail. Use the original photograph 
as the colour palette in order to 
keep a uniform and balanced colour 
scheme all along the picture.

Step 7
yy Now, create a new layer and name it 

‘Left Foreground Mountain’. 
yy Paint rough details as in the previous 

step. 
yy Once done, select ‘Layer 1’ again and 

create a new layer named ‘Middle-
Ground’ (Figure 3.60).

Fig. 3.58: Step 5 for creating Digital 
Matte Painting

Fig. 3.59: Step 6 for creating Digital 
Matte Painting

Fig. 3.60: Step 7 for creating Digital 
Matte Painting
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Step 8
yy We will now add the final creations 

over the original plate, which includes 
the waterfall and another small peak 
towards the background of the ruins.

yy Once done, delete the ‘Outlines’ layer. 
The rough layout must look similar to 
the screen capture. This sketch will give 
a strong feel of what exactly the final 
composition will look like, displaying 
the elements, such as colour, lighting 
and perspective view.  

yy In the next step, we will start to render 
our matte in more detail and try to 
give the painted area more of a photo-
realistic look (Figure 3.61).

Step 9
yy We will start with the sky again. Select 

the ‘Sky’ layer and with a variety of 
different sized brushes, build up the 
layers of cloud. One can always find a 
large-sized photograph and paste it in, 
retouching it a bit with some brushwork 
(Figure 3.62).

yy Make use of adjustment layers and 
colour overlays placed over your sky 
layer, to view changes without affecting 
your working layer.

Step 10
yy Now, we have painted in some 

distant mountains beneath 
the sky to give the painting 
more depth. They are just flat 
colour silhouettes with some 
highlights added to the edges 
(Figure 3.63).

yy Once the sky is done, go to Filter 
> Noise > Add Noise and add a 
bit of Gaussian Noise to help it match 
the ‘film’ grain of the original plate.

Fig. 3.61: Step 8 for creating Digital 
Matte Painting

Fig. 3.62: Step 9 for creating digital 
Matte Painting

Fig. 3.63: Step 10 for creating digital Matte Painting

Unit-3.indd   91 1/7/2021   2:11:48 PM



92

Texturing Artist — Class XI

Practical Exercises
Activity 1

Cropping and cleaning images

Material required
computer, Adobe Photoshop software

Procedure 

yy Select an image, for example rocks, trees, houses of 
high sharpness and detailed quality (to be used later as 
foreground image in Matte Painting).

yy Crop and clean the image, in accordance with the 
requirement of a large Matte Painting scene.

yy Select the second image, for example ocean coast, river 
bank, forest with lesser sharpness, or detail to act as 
mid-ground image of a large Matte Painting scene. 

yy Crop and clean the image, in accordance with the 
requirement of a large Matte Painting scene.

Activity 2

Mixing foreground and background image for a matte painting

Material required
computer, Adobe Photoshop software

Procedure  

Create a single Matte Painting scene of size 1920 × 1080 pixels, 
Colour Mode: RGB, Resolution: 150 pixels/inch, by using 
masking and mixing tools of Adobe Photoshop to create:

yy Foreground image (with full detail and sharpness)
yy Import and mix the mid-ground image (with lesser detail 

and sharpness) and place it behind the foreground 
image.

yy Now, import the background image in this same mixed 
single Matte Painting file and mix it with the third image, 
which is almost a blurred image like blue or evening 
sky or out-of-focus background like a mountain range, 
sea or ocean water or large river water).

Activity 3

Given below are certain steps for digital Matte Painting. 
Arrange them in sequence.

1.	 Use the photoshop eraser tool to remove the photograph’s 
sky, and then, create a new layer.

2.	 Add some storm clouds to the sky and establish the 
light source. One can use a variety of different sized 
soft brushes.

Notes
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3.	 Ensure that the sky layer is still selected and create a 
new layer called ‘right mountain’.

4.	 One can create a new layer and name it ‘left foreground 
mountain’. Paint in the rough details as in the previous 
step.

5.	 Select ‘layer 1’ (the layer that is the original photograph) 
and create a new layer, which can be named ‘right 
foreground mountain’.

6.	 Open a new document by Group to File > New and 
create a blank canvas of 5700 × 3900 pixels.

7.	 Now, we have the general outline of our new image and 
we can start painting in more detail. Always begin with 
the element that is the furthest (usually, the sky).

Check Your Progress 
A.	 Fill in the Blanks

1.	 A painted representation of a landscape or distant 
location that allows a filmmaker to create the illusion 
of an environment that is not present at the filming 
location is known as ________________ painting.

2.	 __________ paintings made through the Adobe Photoshop 
usually resemble a real painting made with real brushes 
and paint and they look more realistic than a vector 
painting or illustration.

B.	 Subjective Questions

1.	 What is ‘matte painting’?
2.	 Describe the steps of matte painting in Adobe Photoshop.

Session 7: Frame Composition

Frame composition is a guideline, which can be applied 
in many situations to enhance the impact of a scene. 
These guidelines will help the students to take more 
compelling photographs, lending them a natural 
balance, focusing attention to the important parts of 
the scene, or leading the viewer’s point of view.

Once familiar with these composition tips, one will 
be surprised at how universal these compositions are. 
One can identify them everywhere and find it easy to 
see why some photos look more attractive while others 
look like simple snapshots.

Notes
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Rule of Thirds
Rule of Thirds is not any rule, but a guideline intended 
to help when the user is uncertain regarding the 
placement of elements in a scene, or when the user is 
framing the picture. As we have studied about the Rule 
of Thirds in Chapter 2, the whole image is divided into 
nine equal segments by two vertical and two horizontal 
lines. It implies that one must position the most 
important elements in a photo or scene along these 
lines, or at points where they intersect. By doing so, it 
will add balance to the photo (Figure 3.64). 

Fig. 3.64: A view explaining how the temple and horizon are aligned along 
the lines in Rule of Thirds 

Notes

Balancing elements
Photographs contain one or more subjects. Placing your 
main subject off-center, as with the rule of thirds, creates 
a more interesting photo. However, it can leave a void in 
the scene which can make it feel empty. Therefore, you 
should balance the ‘weight’ of your subject by including 
another object of lesser importance to fill this space. 
This is called as balance in photography. There are two 
types of balance in photography: (i) formal balance, also 
called symmetrical balance, the one in which images are 
repeated symmetrically on each side of a given point, and 
(ii) informal balance, also called asymmetrical balance, 
the one in which one or more dissimilar elements  are 
balanced on each side of a given point. 
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Leading lines
When we look at a photo, our eyes are naturally drawn 
along lines. Lines in the composition can affect the way 
we see an image, pulling us into the picture or towards 
the subject in the scene. There are many different types 
of lines namely straight, diagonal, curvy, zigzag, radial, 
etc., and each can be used to enhance the composition 
of photo (Figure 3.65).

Fig.  3.65: Lines on the road in this photo draws one’s eye through the scene with the 
single point vanishing view

Symmetry and patterns
Symmetry refers to a sense of harmonious 
and beautiful proportion and balance. We are 
surrounded by different types of symmetries 
and patterns — both natural and man-made. 
These can be used to define and draw the focus 
of the viewer to the subject. They can be used 
as eye-catching compositions; particularly 
in situations where they are not expected  
(Figure 3.66). 

Viewpoint
Before photographing the object or subject, 
take time to think about the location from 
where you will shoot. The photographer’s 
viewpoint has immense impact on the 
composition of the photo clicked, and thus, 
can largely affect the message that the shot 
conveys. Instead of just shooting from the eye 
level, consider photographing from a height, 
at the ground level, at the side, back, far away, 

Fig. 3.66: A view of symmetry and patterns

Fig. 3.67: Viewpoint chosen here creates 
an interesting perspective
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very close and so on. Changing the 
viewpoint is a great way to enhance 
a composition (Figure 3.67).

Depth
As you might be aware that 
photography is a 2D (two-
dimensional) medium, we have to 
choose our composition carefully so 
as to convey the sense of depth as 
present in the actual scene. One can 
create depth in a photo by including 
distinct objects in the foreground, 
middle ground  and background. 
Another useful composition 
technique is overlapping, where we 
deliberately partially obscure one 
object with another. The human 
eye naturally identifies these three 
layers and mentally separates them, 
creating an image with greater depth 
(Figure 3.68).

Framing
Framing in photography is the 
presentation of visual elements in 
an image, especially the placement 
of the subject in relation to other 
objects. It refers to using elements 
of a scene to create a frame within a 
frame. Adding a focal point through 
framing, shows the viewer exactly 
where to look (Figure 3.69).

Cropping
Cropping is the removal of unwanted 
outer areas from a photograph 
or an image. By cropping close 
to the subject, one can eliminate 
the background, ensuring the 
subject gets the viewer’s attention  
(Figure 3.70).

Fig. 3.68: Depth of a scene —Rock, Yacht, Boat 
and Ocean

Fig. 3.69: Framing

Fig. 3.70: Cropping
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Follow the given steps to crop an image:
yy Select the Crop Tool  on the Toolbar. 
yy Select an area of the image to retain (just the 

same as making a normal selection).
yy When you release the mouse button, the area to 

be retained is highlighted. 
yy You can move or transform the crop area by 

dragging the selection or the selection handles.
yy Press Enter key to perform the crop.
yy You can combine cropping and resizing in the 

same operation, using the options in options bar.

Experimentation
Photography is a creative and most expressive art form. 
Experimentation in photography is often described 
as using alternative techniques to photograph a 
subject. A photographer who does experimental 
photography uses techniques that are not common 
with the usual photography or digital photography.  
The most common experimental photography is 
photomontage (Figure 3.71). This technique involves 
the act of combining pieces of photographs and using 
different types of graphic materials. Another form 
is performance art photography, which combines 
photography and performance art (Figure 3.72).

Fig. 3.71: Photomontage Fig. 3.72: Performance Art Photography
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Practical Exercises
Activity 1

Taking photographs from different viewpoints 

Material required

DSLR Camera

Procedure 

yy You can change your elevation. Kneel down and take a 
photo or hold the camera above your head and shoot 
down on your subject. 

yy You can move right or left while clicking the subject. 
yy You can go aside your subject or behind them or even 

get closer or further away. 
yy You can at times roll diagonally from right or left. 
yy Notice how the background shifts and the viewpoint 

changes. 
yy You will notice that changes in viewpoint can add a 

deeper meaning or feeling to an image.

Activity 2

Creating compositions from different angles

Material required

Computer, Adobe Photoshop software

Procedure  

yy Create a digital graphic with a blank canvas of size 
800 × 600 pixels, Resolution: 150 pixels/ inch, white 
background and RGB default colour mode.

yy Import one digital photograph, resize by scaling it and 
creating a new composition from wide angle shot to 
mid-shot, thereby forming a new composition. 

yy Save the file in JPG format to compare it with its 
previous composition.

Activity 3

Applying Rule of Thirds to an image

Material required

Computer, Adobe Photoshop software

Procedure

yy Create a digital graphics with a blank canvas of size 
800 × 600 pixels, resolution: 150 pixels/inch, white 
background and RGB default colour mode.

Notes
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yy Import a digital photograph with a landscape and sky 
or any other image of your choice. 

yy Use the Rule of Thirds and create a new composition. 
yy Save the file in JPG format.

Check Your Progress
A.	 Fill in the blanks

1.	 Rule of Thirds is not any rule, but it is a guideline 
intended to help you when you are uncertain as to the 
placement of elements in a _________ or when you are 
framing the picture. 

2.	 In Rule of Thirds, the whole image is divided into 
_____________ equal segments by two vertical and two 
horizontal lines.

3.	 The two types of balance in photography are 
_____________balance and informal balance. 

4.	 Informal balance, also called as ____________________ 
balance is the one in which one or more dissimilar 
elements are balancing on each side of a given point.

5.	 Symmetry refers to a sense of harmonious and beautiful 
proportion and __________________.

6.	 Cropping is the removal of ________________ outer areas 
from a photograph or an image. 

7.	 Photomontage is the technique that involves the act of 
combining pieces of photographs and using different 
types of ______________ materials. 

B.	 Subjective Questions

1.	 Write short notes on the following:
(a)	 Rule of thirds 
(b)	 Symmetry and patterns 
(c)	 Leading lines 

What have you learnt?
On completion of this Session, you will be able to:

yy describe the rule of thirds and its applications;
yy differentiate between the formal and informal balancing 

in photography; 
yy explain the meaning and purpose of viewpoint, symmetry, 

depth and framing in photography; and
yy crop an image in Photoshop using Crop Tool.

Notes
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Lighting plays an important role in how we view objects. 
The texture and depth of an object shows variation, 
as the intensity and type of light changes. Special 
effects in animation depend significantly on lighting, 
as it changes the way the object is presented with the 
help of tones, contrast and hues. Lighting is the work 
of a separate department in a big animation studio. 
However, as a texturing artist, an individual must 
know how to create mood and visual shaping through 
lighting. Specific lighting scenarios, including character 
lighting, environment lighting and lighting an animated 
sequence must be mastered by those aspiring to become 
a texturing artist. 

Session 1: Effective Lighting for 
Photography

You have learned about camera angles and camera 
movements. Here, you will be learning about the basics 
of photography, including its principles. The brightest 
light comes from the Sun, which is a white light source 
and generates sharp-edged shadows. The second source 
of light is the blue sky. As a result, it has soft shadows 
(which are completely masked by the direct light coming 
from the Sun). Smaller the source of light, the harder 
the shadows.

4 Lighting for 
Photography

4
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Lighting is deliberately used to attain an aesthetic 
objective. Some of the objectives which are attained 
with lighting are as follows:

yy Establishing a setting
yy Setting a visual style
yy Creating visual interest
yy Enhancing or creating the mood of a scene
yy Directing the eye
yy Creating the illusion of depth
yy Creating the illusion of volume
yy Revealing the substance and qualities of materials
yy Maintaining continuity
yy Integrating visual elements

Sources of Light for Photography
Natural light refers to sunlight or daylight, while artificial 
light refers to all kinds of light sources, including 
fluorescent lights, electric lights, flash, and so on. 
Factors, like time of the day, weather, location and air 
pollution affects the use of natural light for photography. 

The best infrared photographs therefore tend to be 
captured in direct sunlight. There are four main sources 
of artificial light for photography— 

(i)	 Incandescent: This lighting ranges from the 
common light bulb to large tungsten ‘hot lights’ 
used in the studio. They are warm in colour and 
temperature, as compared with natural daylight. 
Halogen bulbs are colder and produce a light that 
is blue in colour, while tungsten bulbs, being 
hotter, produce light with a reddish hue.

(ii)	 Fluorescent
(iii)	Light Emitting Diode (LED)
(iv)	Studio strobe: Strobe lighting is probably the most 

common used artificial lighting in photography. 
Strobe lighting is not suitable for video, as the 
duration of the flash is too short.

Choice of type of light
The choice of the type of light to be used, depends on 
the type of photography, the subject, and the desired 

Fluorescent lamp is a 
mercury lamp that uses 
fluorescence to deliver 
visible light. It comes in 
a wide variety of colour 
temperatures.

LED is a semiconductor 
device that emits visible 
light when an electric 
current passes through 
it. The output of LED 
can range from red to 
blue-violet.
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effect. Hard light produces well-defined, dark shadows 
and tends to originate from a single light source, which 
is usually either small or located far away. Hard light 
can be used to create images with sharp contrast 
and highlights, emphasising the shape and texture. 
It can be used to enhance the 3D effect of an image 
and in general, to create dramatic effects. Soft light, 
on the other hand, produces either soft shadows or no 
shadows at all. It can be generated from several light 
sources, by diffusing light using some kind of barrier 
or by reflecting light from different surfaces so that the 
subject is hit by the light from various angles. The action 
of reflecting light essentially turns the reflector into a 
secondary light source. All kinds of things can be used 
as reflectors, whether shooting indoors or outdoors. 
These include professional photo light reflectors or just 
sheets of paper.

The narrower the source, the harder the light. A 
broad light source lessens shadows, reduces contrast 
and suppresses texture. The farther the source, the 
harder the light.

Angle of light
The angle of light should be taken into careful consideration 
for creating a specific effect. The angle from the light 
source (e.g., the sun) to the object or subject and then 
to the camera is called the ‘phase angle’. The angle of 
incidence of the light source (e.g., the sun) on an object or 
the subject along with the phase angle sets the shading. 
The larger-scale shading is important from the point of 
view of showing the form. The smaller-scale shading is 

Fig. 4.1: Phase angle

Notes
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important for showing texture. The various phase angles 
have been summarised in the table given below:

Angle of light 
(degrees)

Position of light Example

0 Front, with no shadows Sun is behind your back

45 Front, with small shadows ———
90 Side Sun is on your side
135 Side and back Transmitted light from subjects
180 Back Transmitted light and diffracted light

Fig. 4.2: Angles of light

Front, direct 45-degree Side or 90-degree Side with reflector fill

reflector

Bounced light
When light hits a surface, it either bounces back or 
is absorbed by it. For example, the colour of the wood 
is enhanced by the fact that light of the same colour is 
reflecting onto it. The result is that the coloured light and 
the underlying surface combine to create a glowing and 
saturated version of the wood’s existing colour. Direct 
flash is harsh, but if you use bounce flash, it re-directs 
the light to bounce off an object and back to the subject. 
Soft light tends to wrap around objects, projecting diffused 
shadows with soft edges. 

High key images
High key photography uses unnaturally bright lighting 
to blow out most or all harsh shadows in an image. It 
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generally involves using extra lights. High key lighting is 
often soft and the detail is generally low. High key lighting 
can be seen in fog and snow, where even shadows are light 
due to the amount of reflected light bouncing around. 

Fig. 4.3: High key image Fig. 4.4: Low key image

Low key images
Low key images have very little light in them. A low key 
image contains predominantly dark tones and colours.

White balance
Each source of light possesses a different colour 
temperature. A digital camera can measure the colours 
in the red, green, and blue light of the spectrum. Since 
different sources of light have different colour hues, 
a picture taken with a normal white balance under 
artificial lighting conditions transmits the low heat 
to the camera’s sensor. A light having higher colour 
temperature will have more blue light or larger Kelvin 
value, as compared to lower light, which has a smaller 
Kelvin value. An image taken under tungsten bulb  
without adjusting the digital camera for white balance 
produces a dull orange shade. An image taken under 
the fluorescent lighting produces a brighter bluish cast. 
By adjusting the white balance setting of your digital 
camera, you can alter the required light or temperature 
to produce the most accurate colours in a digital image. 
The pre-set modes for white balance settings are as 
follows: 
Auto — It helps in adjusting the white balance 
automatically according to the different lighting 
conditions.
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Tungsten — It is used for light under a little bulb, and 
it is often used while shooting indoors. 
Fluorescent — It is used for getting brighter and 
warmer shots while compensating for the cool shade of 
fluorescent light.
Daylight — It is for the normal daylight setting while 
shooting outdoors. 
Cloudy — It is ideal for shooting on a cloudy day. This 
is because it warms up the subject and surroundings 
and allows you to capture better shots.
Flash — It is required when inadequate lighting is 
available. 
Shade — This mode generally produces cooler or bluer 
pictures.

Practical Exercises
Activity 1

Creating a scene with light bounce and shadows

Material required

Computer, Adobe Photoshop software

Procedure

yy Create a digital graphic with a blank canvas of size 
800 × 600 pixels; Resolution: 150 pixels/inch; White 
background and RGB default colour mode. Import 
any Digital Photograph, resize by scaling it and create 
a scene. Now, apply various highlighting and image 
enhancing techniques and create a scene with:
1.	 Light bounces (from the solid wall, building, 

reflecting surface)
2.	 Prominent shadows (of a building or tree). 

yy Save the file in JPG and PSD format to compare it with 
the previous composition.

Activity 2

Creating a scene with high and low key

Material required

Computer, Adobe Photoshop software

Procedure

yy Create a digital graphic with a blank canvas of size 
800 × 600 pixels, Resolution: 150 pixels/inch, White 
background and RGB default colour mode

Notes
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yy Import any one digital photograph, resize by scaling it 
and create a scene. Now, apply various lighting, image 
editing techniques and create a scene with:
1.	 High key 
2.	 Some portion (background or sky) with low key 

setting
yy Save the file in JPG and PSD format to compare it with 

its previous composition.

Check Your Progress
A.	 Fill in the Blanks

1.	 Red light has a _______________ wavelength compared 
to blue light. 

2.	 The Sun’s light glows red at sunset because the 
________________ wavelength blue colour gets lost due 
to scattering.

3.	 An object which is having _____________ colour will reflect 
all wavelengths equally when light hits the surface.

4.	 An object which is having _________________ colour will 
absorb all light when light hits the surface. 

5.	 When white light hits a red surface, the _______________ 
and _______________ lights are absorbed and red light is 
reflected.

6.	 Radiance is, usually, a subtle effect and a great deal of 
__________________ is required to make it apparent. 

B.	 Subjective Questions

1.	 Explain in brief, the following terms related with colours:
(a)	 High Key
(b)	 Low Key 

2.	 Why is the sky blue?

What Have You Learnt?
On completion of this Session, you will be able to:

yy describe the basic qualities of light (intensity, contrast, 
direction and diffusion).

yy demonstrate the use of different types of lighting effects 
on images.

yy identify different types of light and settings for 
photography.

yy differentiate between high key and low key images.

Notes
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Unit 1: Colour Theory
Session 1: Principles of Colour Theory 

A.	 Fill in the blanks

1.	 Hue			
2.	 Saturation
3.	 Value
4.	 white
5.	 black
6.	 grey
7.	 wheel

Session 2:  Colour Wheel 

A.	 Fill in the blanks

1.	 primary
2.	 Artist colour wheel
3.	 Digital
4.	 orange
5.	 green
6.	 violet
7.	 red, yellow, blue

Session 3: Digital Colour Wheel

A.	 Fill in the blanks

1.	 electronic 
2.	 RGB
3.	 yellow

Session 4: RGB Display Mechanism

A.	 Fill in the blanks

1.	 image
2.	 one
3.	 numerical
4.	 pixels

Session 5: Colour Schemes

A.	 Fill in the blanks

1.	 complementary
2.	 contrast
3.	 warm
4.	 cool
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Unit 2: Digital Photography and Pre-production
Session 1: Camera Angles and Movements 

A.	 Fill in the blanks

1.	 high-angle
2.	 low-angle
3.	 eye-level
4.	 bird’s eye 
5.	 high-angle
6.	 Pan
7.	 Tilt
8.	 Dolly 
9.	 Zoom 

10.	 size
11.	 focus
12.	 Exposure 
13.	 Hot
14.	 light
15.	 shutter

Session 2: Pre-production

A.	 Fill in the blanks

1.	 production
2.	 storyboard
3.	 storyboard
4.	 design
5.	 Model
6.	 storyboard

B.	 Match the Columns

1.	 (c)		  2. (b)		  3. (a)

Unit 3: Drawing and Painting using Adobe Photoshop
Session 1:  Introduction to Adobe Photoshop 

A.	 Match the columns

1.	 (a)		  2. (d)		  3. (b)		  4. (c)

Session 2:  Drawing and Painting Tools 

A.	 Fill in the blanks

1.	 lines
2.	 raster
3.	 vector
4.	 pencil
5.	 Move

Notes
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6.	 Marquee 
7.	 Lasso 
8.	 swatches

Session 3: Blending Modes

A.	 Match the columns

1.	 (c)		  2. (b)		  3. (a)		  4. (d) 

Session 4: Colour Modes

A.	 Multiple Choice questions

1.	 (a)		  2. (d)		  3. (b)		  4. (c)

Session 5: Image Adjustment and Colour Correction

A.	 Fill in the blanks

1.	 saturation 
2.	 balance
3.	 shadows

Session 6: Digital Matte Painting

A.	 Fill in the blanks

1.	 Matte 
2.	 Raster

Session 7: Frame Composition

A.	 Fill in the blanks 

1.	 scene
2.	 nine
3.	 formal
4.	 asymmetrical
5.	 balance 
6.	 unwanted
7.	 graphic 

Unit 4: Lighting for Photography
Session 1: Effective Lighting for Photography

A.	 Fill in the blanks

1.	 longer
2.	 shorter
3.	 white
4.	 black
5.	 blue, green
6.	 light

Notes
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Glossary

2D map: Two-dimensional map consists of either a bitmap or a 
procedural map. Texture coordinates are essential for mounting a 
2D map on 3D model. 
2-sided polygon: A polygon that has a front and a back, and is 
2-sided. A 2-sided polygon has two normal surfaces, facing the 
opposite directions. For example, a playing card.
3D map: Three-dimensional map is either built from multiple layers 
of bitmaps or generated in three dimensions with a procedural 
texture. 
3D object: The most common 3D objects are geometric objects, which 
can be classified according to whether they are polygon meshes, 
surfaces, curves, implicit objects or nulls.
Additive opacity: The type of opacity that adds background colour 
to the material’s colour of the transparent object.
Alpha channel: One of the four channels (or components) of 
information that make up every pixel in an image. There are three 
channels for red, green and blue (RGB) and one alpha channel.
Ambient light: It is the light that is already present in a scene, 
before any additional lighting is added. 
Ambient map: This allows manipulation of the ambient component 
of an object’s reflection-illumination model. Usually, the ambient 
component is given a value near that of the diffuse component.
Angle of view: The viewable field covered by a lens, measured in 
degrees.
Animation:  The process of creating a progressively altering image 
that gives the appearance of continuous motion.
Aperture: The opening size of a camera lens. The greater the 
aperture, the smaller the depth of field and the greater the amount 
of light entering the lens.
Aspect ratio: A description of the proportion of an image by 
comparing its width to its height. 
AVI: Audio Video Interleave is a popular file format that combines 
video and audio.
Axis of motion: In 3D space, the axis that an object follows during 
movement.
Axis of rotation: In 3D space, the axis around which an object 
rotates is called an axis of rotation.
Bit: The building blocks of computer data. It has either the value of 
1 or 0. 
Bitmap: It is a grid where each individual square is a pixel that 
contains colour information. 
Blending: The mixing of two (or more) textures into one final texture 
that is displayed in rendering.
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Byte: It is equal to 8 bits. Multiples of bytes make the terms kilobyte 
(1024 bytes), megabytes (1024 kilobytes) and gigabyte (1024 
megabytes).
Camera: It is an optical instrument used to record images. A 
digital camera is a hardware device that takes photographs and 
stores the image as data on a memory card. 
Centre point: A point that represents the centre of an object. The 
centre point of a polygon is where the line representing the normal 
comes out from.
Compositing: The process of combining multiple elements shot 
separately (still images, movie clips) into a final image or sequence 
to give an impression that they were all shot at the same time.
Depth of field: The total distance on either side of the point of focus, 
which when viewed from an appropriate distance, appears sharp in 
the final print.
Dimension: A measure of spatial extent, especially width, height 
or length.
Dots per inch, DPI: This refers to the number of dots that exist 
within each inch of a bitmapped image. 
Field of view: It is the open observable area that a person can see 
through one's eyes or via an optical device.
Frame: A frame in photography is a static image, which when 
followed by other static images sequentially gives the illusion of 
motion. 
Framing: In photography, it refers to the technique of drawing focus 
to the subject in the photo by blocking other parts of the image with 
some image in the scene.
Frame rate:  It is expressed as Frames per Second (FPS). It is 
the amount of individual video frames that a camera captures per 
second.
Hue: The position of a colour in the spectrum that describes the tone 
or tint of a colour, such as red, yellow, or blue.
JPEG (Joint Photographic Experts Group): A widely accepted, 
international standard for compression of colour images.
Layer: It is a portion of a scene. Each layer consists of an object 
or multiple objects that can be edited separately from the rest of 
the objects in a scene. In photoshop, layers act as pieces of images 
stacked on each other.
Layout: The art or process of arranging printed or graphic matter 
on a page.
Luminance: The black and white information (brightness, 
sharpness, and contrast) encoded in a colour. The amount of 
luminance contained in a colour is directly proportional to the 
amount of light intensity.
Model sheets: These are also used for reference in 3D modelling. 
It is, usually, used as reference material so as to allow proper 
proportions in 3D modelling.

Notes
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Opacity: Opacity is the state of a body that makes it impervious to 
the rays of light.
Plane: Plane refers to a two-dimensional (i.e., flat and level) surface. 
Imagine a plane as a piece of glass that is infinitely large but has 
no depth.
Polygon: A geometric shape in one or many planes. Polygonal 
modelling consists of using many faces to create the shape. 
Primary colours: There are three primary colours of light —red, 
green and blue (RGB).
Raster image: also called bitmap graphics, a type of digital image 
that uses tiny rectangular pixels, or picture elements, arranged in a 
grid formation to represent an image. (Britannica) 
RGB colour model: It is an additive color model in which red, green, 
and blue light are added together in various ways to reproduce a 
broad array of colours.

Notes

Answer Key .indd   112 1/7/2021   2:14:43 PM



Notes

Answer Key .indd   113 1/12/2021   4:02:18 PM



Notes

Answer Key .indd   114 1/12/2021   4:02:31 PM


